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Read Me First


Please read this user manual carefully before using your PMRS-102 device to ensure
safe and proper use.



The descriptions in this manual are based on the default settings of your device.



Content and images used in this manual may differ from the actual product.



Software images and screenshots used in this manual may differ in appearance from
the actual software, depending on the software version in use.



The stability and performance of the PMRS-102 unit’s wireless data streaming may
vary in different countries, due to bandwidth and reception capabilities of the
available carrier wireless networks and service providers in each country.



Every effort has been made to ensure that the information in this user manual is
accurate. Infodraw is not responsible for printing or spelling errors.



Please keep this manual for future reference.



To get support please contact your local distributor with a detailed account of the
problem you have encountered.
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Safety Precautions
To prevent damage to your PMRS-102 device or injury to yourself and others, please read
the following safety information prior to using your device.

WARNING
To prevent damage, electric shocks, fires and/or explosions:


Do not use damaged power charger cords or plugs, or loose electrical sockets.



Do not touch the PMRS-102 device or the power charger cords with wet hands.



Do not place or use this product near water or wet locations.



Do not twist, bend, cut or damage the power charger cords.



Do not drop or cause an impact to the PMRS-102 device or the power chargers.



Do not place your device on an object where it is likely to fall. If your device falls, it
may get damaged.



Do not charge the PMRS-102 device with chargers that are not approved by the
manufacturer.



Do not use the PMRS-102 device if the built-in lithium battery is damaged or leaking.



Avoid exposing the PMRS-102 device to very hot or very cold temperatures. Extreme
temperatures may cause deformation of the device and reduce the charging capacity
and/or life of your device/ battery.



Do not use or store your device in dusty or dirty areas.



Do not allow children to use your PMRS-102 device.

When turning the unit on:


To turn the PMRS-102 unit on, locate the ON/OFF switch on the side of the unit.
Carefully move the switch to the ON position until it clicks and the LED lights turn on.
Repeat the process to turn it off.



Before turning the unit ON, please make sure that the GSM Antenna is connected to
its appropriate antenna connector on the unit. If the SIM card is inserted into the
unit and the unit is turned ON without the GSM antenna being connected, this may
cause harm to the internal cellular modem. Therefore it is recommended to keep
the GSM Antenna connected all the time.



After turning the unit OFF, please wait until the LED’s on the top of the unit shut off
completely before turning the unit back ON.
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When charging the unit:


The PMRS-102 unit’s maximum power input is 5V. The chargers supplied by Infodraw
provide the correct (5V) power output to the unit. WHEN CHARGING THE UNIT,
ONLY USE THE CHARGERS PROVIDED BY INFODRAW. DO NOT CHARGE THIS UNIT
WITH ANY HIGHER VOLTAGE THAN 5V. THIS MAY CAUSE IRREVERSIBLE INTERNAL
DAMAGE TO THE UNIT’S HARDWARE COMPONENTS.



Never use a damaged charger to charge the device.

When configuring the unit:


The PMRS-102 unit has to be configured prior to operation and later on as well. The
configurations are done using the Device Configurator Application on any PC,
through the USB Cable provided. MAKE SURE THAT ANY SIM CARD IN THE UNIT IS
REMOVED BEFORE CONFIGURING THE UNIT THROUGH THE USB CABLE.

Using the unit’s Dip Switches:


The PMRS-102 Unit has 4 Dip Switches used for setup and operation, located on the
side of the unit. The functions of each dip switch can be found in the Dip Switch
section of the Unit Hardware Interfaces chapter in this manual. Make sure you
understand the functions of each dip switch, prior to using the unit.

When installing the unit in a vehicle:



Only use Infodraw Chargers to charge the PMRS-102 Unit. Non-Infodraw chargers
are not covered by the 1 Year Limited Warranty.
When installing custom 12V Power Outlets directly into vehicle batteries, please
ensure that this is done by a qualified, experienced Auto Electrician.

Disposal and Recycling:
Please ensure this product is recycled in an environmentally friendly way. You must dispose
of the PMRS-102 device properly according to local laws and regulations. As the PMRS-102
device contains electronic components and a lithium battery, it must be disposed of
separately from household waste. When the PMRS-102 device reaches the end of its life,
contact local authorities to learn about disposal and recycling options.

Copyright
© 2012 Infodraw R&D LTD. All rights Reserved.
Information in this manual is protected by copyright laws and is the property of INFODRAW.
No part of this manual may be reproduced, copied, translated, or published in any form or
by any means without INFODRAW’s prior permission. Information is this manual is subject
to change by INFODRAW without prior notice.
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Required Items
SIM Card (Data only)
3G/ HSPA/ EDGE/ GPRS

A SIM Card (Data Only) from your cellular
service provider is required for the unit. The
PMRS-102 unit supports most 3G/ HSPA/
EDGE/ GPRS SIM based cellular providers.
Devices compatible with 4G/LTE technology
are available, but have to be ordered in
advance – the PMRS-102L.
* It is recommended for the SIM to be of high
speed (HSPA or faster) and have a large
browsing package – at least 3GB.

Camera
Any analogue PAL/NTSC camera with a
RCA connector for video output can be
connected to the PMRS unit. The unit
supports 1 camera. The unit’s battery
can feed power to a 5V camera for
portable use.

Micro SD Card
A Micro SD Card is required if you would
like to record in the PMRS-102 device.
The speed of the Micro SD Card will vary
depending on the make. The PMRS unit
supports most Micro SD Cards (SDHC).
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Included Software
The following software is included with the PMRS System:
MRS Server (Windows Service Program):
This is a Web Admin Interface program and is used for
setting up your server for MRS/PMRS units to connect to,
setting permission and access levels for connecting
clients and configuring a variety of other settings in the
server. With this program, the server’s settings can be
accessed and changed from any location, using the web.

MRS Monitor (Client) Application:
This is the application through which you are able to watch
the video, listen to the audio and monitor the location of your
PMRS devices. In this application you are able to change the
parameters of the video and audio and view the recordings
you have made.

MRS Device Configurator Application:
This application is used for configuring the PMRS device
parameters prior to operating the unit and for upgrading
the unit’s firmware. The unit is configured through a USB
Cable interface on any PC (Windows XP or higher).

MRS AV Player Application:
This application is used for viewing recorded
video/audio files. It is also used to verify recorded files
that have a digital signature assigned to them, as well
as decrypting recorded files that are encrypted with a
key.

13
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iMRS iPhone Client:
iMRS is used for monitoring video/audio/location
streams from MRS/PMRS devices, on your iPhone.

MRS Android Client:
MRS Android Client is used for monitoring
video/audio/location streams from MRS/PMRS
devices, on your Android powered mobile device.

MRS Monitor (Server) Application:
This application can be used for both server and client
purposes; it has the same features of the MRS monitorclient and the MRS Service program but cannot serve more
than one device at one time and is not accessible through the
web. The MRS monitor is easy to install and operate and is
fitted to the needs of retail clients.

Windows Mobile 5.0/ 6.0 Clients:
Used for viewing the MRS/PMRS unit’s video/ audio/ GPS streams live from your Windows
Mobile Smart Phone.
MRS USB Drivers for Windows XP, Vista and 7 (32bit):
These drivers must be installed on your PC to allow the PMRS unit to connect to the Device
Configurator Program using the USB cable.
MRS USB Drivers x64 for Windows 7 (64bit):
These drivers must be installed on your PC to allow the PMRS unit to connect to the Device
Configurator Program using the USB cable.
MRS ActiveX Control Software:
Used for integrating the MRS system with other control software.


The MRS Software will be burned for you on a CD provided by your local distributor.
14
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Chapter 1 - Introduction
1-1

Document Scope:

This document describes the setup configurations, the features and operational functions of
the PMRS-102 Unit. It also provides technical specifications, as well as troubleshooting help
and answers to frequently asked questions (FAQs).

1-2

Terminology:

Below is a list of descriptions for the abbreviated terms used in this manual.

Term:
PMRS
IP
TCP
UDP
GPS
GSM
3G
HSPA
EDGE
GPRS
SIM
SD
PC
USB
M2M
TRS (TRRS)
PTZ
VMD
GPIO
SMS
APN
LAN
PIN
PUK
LED
TTL

Description:
Personal Media Relay System
Internet Protocol
Transmission Control Protocol
User Datagram Protocol
Global Positioning System
Global System for Mobile Communications
3rd Generation Mobile Telecommunications
High Speed Packet Access
Enhanced Data rates for GSM Evolution
General packet radio service
Subscriber Identity Module
Secure Digital
Personal Computer
Universal Serial Bus
Multi Unit to Multi Client
Tip, Ring, Sleeve
Pan, Tilt, Zoom
Visual Motion Detection
General Purpose Input, Output
Short Message Service
Access Point Name
Local Area Network
Personal Identification Number
PIN Unlock Key
Light-emitting diode
Transistor–transistor logic
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Introduction:

The Infodraw PMRS-102 unit is a portable handheld multimedia streaming and monitoring
system from the field. It allows users to stream live video/audio/location from anywhere
over wireless cellular networks (3G/ HSPA/ EDGE/ GPRS) or (LAN) and can be monitored and
controlled from any location upon alarm/ request. The media streaming is done using PMRS
units which can be carried handheld or located either on mobile vehicles or fixed locations.
The units can be monitored remotely from fixed/mobile control centres, mobile
phones/PDAs or an internet web client.

1-4

System Components:

The system consists of the following components:

PMRS units, which can stream 1 video
channel, 1 audio channel and GPS location
over the cellular network or LAN to the
MRS server.

MRS Server, which communicates with
units and clients.

MRS Clients, which communicate with
the server and have viewing and control
capabilities for all connected units, as
defined by the server.
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System Architecture:

 Server Based Architecture: This architecture is based on a server with a fixed IP
address. Multiple units can communicate with the server as well as multiple clients.
All clients are connected to the server only and have viewing and control capabilities.
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Chapter 2 - Hardware Interfaces
Listed below are the explanations of the PMRS Unit’s hardware interfaces.

2-1

Video Input/ 5V Power Output:

The unit has a standard 2.5mm TRRS female input connector which supports the video input
and 5V power output to the camera from the unit. The input is labelled A/V IN on the PMRS
Unit.

2-2

Video / 5V Power Adapter Cable:

The unit comes with a 2.5mm TRRS Male Jack splitter cable which has a RCA Connector for
Video Input (Yellow connector) and a 5V DC Power Connector (black connector) for Power
Output to a camera (Max 5V). The White RCA Connector in this cable has no use. Connect
this adapter cable to the Video/ Power TRRS Female Input Connector shown above (A/V IN).
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Audio In/Out:

The unit has a standard 2.5mm TRRS Female Input Connector which supports the Audio Line
In and Audio Line Out of the unit. The input is labelled with a Headphones Symbol on the
PMRS Unit and is located next to the “A/V IN” input. Headphones can be connected here
directly.

2-4

Audio In/Out Adapter Cable:

The unit comes with a 2.5mm TRRS Male Jack splitter cable which has a 2.5mm TRRS Female
connector for Audio In (Pink Connector) and a 2.5mm TRRS Female connector for Audio Out
(Green Connector). A microphone and speakers can be connected to this cable (pink
connector for microphone, green connector for speakers). Connect this adapter cable to the
Audio In/Out TRRS Female Input Connector shown above (Labelled with Headphones).
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Antennas Option 1 (External GSM and GPS):

With this antenna setup, the PMRS unit has two external SMA antenna connectors located
on the top side of the unit for External GSM and GPS Antennas. The GSM antenna connector
is on the right corner of the unit. The GPS antenna is in the middle of the unit.

GPS Antenna

GSM Antenna

GSM Antenna

GPS Antenna

Antenna Base

Antenna

1) Twist the GSM Antenna on to the GSM Antenna Base.
2) Connect the GSM and GPS Antennas to their appropriate antenna connectors shown
above.
WARNING:
 Before turning the unit ON, please make sure that the GSM Antenna is connected to
its appropriate antenna connector on the unit. If the SIM card is inserted into the
unit and the unit is turned ON without the GSM antenna being connected, this may
cause harm to the internal cellular modem. Therefore it is recommended to keep
the GSM Antenna connected all the time.
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Antennas Option 2 (Internal GSM and External

GPS):
With this antenna setup, the PMRS unit has an Internal Antenna for GSM and an External
SMA Antenna connector for GPS, located on the top side of the unit.

GPS Antenna

GPS Antenna

Connect the GPS Antenna to the single SMA
Antenna Connector shown above.
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SIM Card Slot:

The SIM card slot is located on the side of the unit. Pull the notch out carefully with your
fingernails to insert the SIM card. Once the SIM card is inserted properly, close the notch by
carefully pushing it all the way into the unit.

2-8

Alarm Button:

The PMRS unit has a built in alarm button located on the side of the unit. The button can be
used in emergencies and can be set up to trigger a variety of actions on the MRS monitor
(Refer to Alarm Button Section).
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USB Client (Mini USB Input):

The USB client is used for configuring the device’s parameters using the Device Configurator
application. Connect the USB cable between the Mini USB Input shown here and a PC when
configuring the unit.

2-10 Micro SD Slot:

The Micro SD Slot is located on the side of the PMRS unit, next to the SIM Card Slot. Insert a
Micro SD card into the Micro SD slot for recording in the PMRS device. The unit supports up
to a 32GB Micro SD Card (SDHC)
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2-11 ON/OFF Switch:

The ON/OFF Switch is located on the side of the unit, in between the Mini USB Input and the
Dip Switches. To turn the PMRS-102 unit on, carefully move the switch to the ON position
until it clicks and the LED lights turn on. To turn the unit OFF, carefully move the switch back
to the OFF position until it clicks and the LED lights turn off. After switching the unit off, the
LED lights may take up to a few seconds to turn off.

2-12 5V Power Input:

The 5V power input is located on the side of the unit. Connect the 5V Power Charger here.
DO NOT CONNECT MORE THAN 5V INTO THIS INPUT. THIS WILL CAUSE DAMAGE TO THE
UNIT.

24
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2-13 Charging the Unit:
There are 2 ways to charge the PMRS-102 Unit:
1) Using the 5V AC/DC Power Charger: Connect
the AC Charger to a wall power outlet. Connect
the DC tip to the PMRS Unit’s 5V Power Input
shown above. The unit’s battery takes about
10-12 hours to charge from flat to full charge.

2) Using the 5V Car Adapter Charger: The 5V Car
Adapter Charger has a cigarette lighter interface.
Connect the Car Adapter Charger to a cigarette
lighter 12/24V power outlet in a vehicle (either
pre-installed in the vehicle or custom installed
directly into the vehicles battery). Connect the
DC tip to the PMRS Unit’s 5V Power Input shown
above.
Pre-installed Power Outlet

Power Outlet to be installed
directly into vehicle battery

WARNING:



Only use Infodraw Chargers to charge the PMRS-102 Unit. Non-Infodraw chargers
are not covered by the 1 Year Limited Warranty.
When installing custom 12V Power Outlets directly into vehicle batteries, please
ensure that this is done by a qualified, experienced Auto Electrician.
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2-14 Dip Switches:
The PMRS has 4 Dip Switches located on the side of the unit. The dip switches are for setup
and operation. The functions of each switch are described below in order from left to right:

1) USB HOST/CLIENT AND CELLULAR OPERATION:
i. Up Position = USB client (setup through PC)
ii. Down Position = Normal cellular operation
2) USB IN/OUT:
i. Up Position = USB out to connector (setup through PC or WIFI Dongle)
ii. Down Position = USB in on board
3) MICROPHONE:
i. Up Position = Disable
ii. Down Position = Enable
4) SPEAKER:
i. Up Position = Disable
ii. Down Position = Enable
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2-15 LED’s:
The PMRS has 3 LED’s located on the top side of the unit. The 3 LED’s indicate the following:

1)
2)
3)
4)

Green LED – External power is connected.
Red LED – Software status, blinks when software is running.
Blue LED (on) – Modem is on.
Blue LED (flashing every second) – Modem is connected to cellular provider.

CAUTION:


After turning the unit OFF, please wait until all the LED’s on the top of the unit shut
off completely before turning the unit back ON (except the green LED which can stay
on if the unit is being charged).
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2-16 GPIO/PTZ Cable:

The GPIO/PTZ Cable has several different coloured wires for specific purposes such as PTZ
and GPIO. The definitions of the wires are listed below:
INDEX
1
2
3
4
5
6
7
8
9
10
11
12
13
14

COLOR
BLUE
BLUE-WHITE
ORANGE
RED-WHITE
GREEN
PURPLE
PINK
BROWN
BROWN-WHITE
GRAY
YELLOW
RED
WHITE
BLACK

FUNCTION
GPIO IN 1
GPIO IN 2
GPIO IN 3
GPIO IN 4
GPIO OUT 1
GPIO OUT 2
GPIO OUT 3
GPIO OUT 4
PTZ TX+
PTZ TX5V
TTL TX
TTL RX
GND
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The GPIO/PTZ Cable Input is located on the bottom side of the PMRS unit.

Lock Lever:
Press and Hold to unlock
before disconnecting.

Connect the GPIO/PTZ cable to its correct input shown above. Make sure it is firmly
connected.
WARNING:


When disconnecting the cable from the PMRS unit, do not just pull the cable. Press
and hold the Lock Lever (shown here) and then pull it out.
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2-17 Ethernet Cable:
The unit comes with an Ethernet cable for using the LAN Interface.

The Ethernet (Interface) Cable Input is located on the bottom side of the PMRS unit, next to
the GPIO/PTZ Cable Input.

Lock Lever:
Press and Hold to unlock
before disconnecting.

Connect the Ethernet (Interface) cable to its correct input on the PMRS unit shown above.
Make sure it is firmly connected.
WARNING:


When disconnecting the cable from the PMRS unit, do not just pull the cable. Press
and hold the Lock Lever (shown here) and then pull it out.
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Chapter 3 - Installation
3-1

MRS Server:

There are two programs through which a user can run the MRS server:
1. MRS Service Program (Web Admin Interface Server):
This is a Windows Service Program that allows the user to setup a server on any PC or
dedicated server and then access and change settings in the server from any location, using
the web. (Recommended)
2. MRS Monitor-Server Application:
This program allows the user to run the server in the same program where the video and
audio are streaming. However, the “MRS Monitor” program only allows one device to work
at any one time and gives full access to the server only from the computer itself and most of
its features cannot be reached from the web. This server program is fitted for small clients
that have purchased only one device.

3-1-1 Installing the MRS Service
The control centre server software can be installed on any PC using Windows XP or later.
The server requires a Fixed (Static) IP address, which is publicly accessible, in order for the
external units to connect. Please refer to the “Server Technical Requirements” section of
Chapter 4 in this user manual, for full Server Machine Technical requirements. In order to
allow communication between the server and MRS/PMRS Units and Clients, the following
ports must be open in the server machine’s firewall:
12654 TCP
12655 UDP
For setting up the server on a local area network PC, follow these instructions to open the
ports:
1) Make sure your router has a fixed (Static) IP Address. If it doesn’t, you should
arrange to get one through your internet service provider.
2) Enter your router admin settings.
3) Set your local PC (server PC) to have a fixed local (Static) IP Address assigned in the
router.
4) In the routers port forwarding settings, you need to open the above two ports and
then port forward them to your local PC’s fixed local (Static) IP Address.
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5) After opening and forwarding the ports to your local PC in your router, it is also
recommended to open the 2 ports on your local PC itself, in the Windows Firewall
feature. Open “Control Panel > Windows Firewall > Advanced Settings”. In windows
XP and Vista, enter the “Settings” of the ‘operating internet connection’ and add the
new ports. In Windows 7 enter the “Inbound Rules”, open the “Action” menu,
choose “new rule” and follow the instructions to open the 2 ports.
If you are setting up a virtual server with a server hosting company, ask your service
provider to open the above ports in the server for you. The MRS Server can also be set up
on Microsoft Windows Server OS.
The MRS SERVER supports multiple units and clients. Only a single instance of the MRS
SERVER software may be running on a MRS server/system at any one time. The purpose of
the MRS server is to communicate with all MRS/PMRS units and clients and to stream
video/audio/location from units to clients.
To setup the MRS Service Program (Web Admin Interface Server), follow these instructions:
1) Make sure that both MRS Service setup files (“Setup_MRS_Service.msi” and
“setup.exe”) are placed in the same directory on your server machine.
2) Run the “setup.exe” file.
Locate the installed MRS Server folder and run the “MRS_Service.exe” file. This will activate
the MRS Server Windows Service Program on your server machine.

The starting point for the web administration interface is the main menu page, reachable at
the following address (enter this address in your web browser):
http://serverip:12654/admin
'serverip' is the IP address of your server. If the server is installed on the machine where the
web browser is open, you may use 'localhost' as the address.
If a secure connection is desired, use the following address:
https://serverip:12654/admin
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The “Server Administor Login”
screen will appear.
Every time the server does not
identify the browser as the
administrator, it requests the user to
enter the administrator's password.
The initial password is mrs. The
administrator is required to change
this initial password to a different
one, immediately after first login.

* The MRS Service program is a TCP and UDP server that serves MRS/PMRS devices and
monitor clients. It's most basic functionality and prime reason for its existence is to
distribute video packets from cellular MRS/PMRS devices with limited bandwidth to a
number of monitor clients observing the video stream. The MRS Service Program under MS
Windows OS takes form of a Windows Service. A Windows Service has no application-like
user interface as does the MRS Monitor Server Application, so it is instead configured using
a Web Administration Interface. This program allows the user to enter the server through
the Web at any location.
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3-1-2 Installing MRS Monitor-server Application:
The MRS Monitor Server can be set up on any PC using Windows XP or later.
To setup the MRS Monitor Server application, follow these instructions:
1) Run the “Setup_MRS_PC_Application.msi” file.

3) Click “Next”.

2) Click “Next”.

4) Click “Next” to begin installation.
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Once the “MRS Monitor Server Application” is installed and opened, to setup the PC to act
as a server using Server Based Architecture, follow these instructions:

1) Open the “session” menu on
the top left hand side.

2) Open the “Connection”
screen.

3) Select “local server”
and press OK.
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4) Once the server is running, the status bar on the bottom left hand side of the window
should show “Server is listening”.

Server Based Architecture is now activated. Units and Clients can now communicate with
the server. This architecture is recommended for multi-unit to multi-client communication.

CAUTION: If you are connecting multiple MRS/PMRS units to the server, it is recommended
NOT to view the video/audio/GPS streams from the “MRS Monitor Server Application”
itself. The system will be more stable if the data streams are only viewed from other clients
connected to the server. The server software should be used primarily as a communication
program between MRS/PMRS units and MRS Clients. Therefore, when connecting multiple
units to the server, it is recommended to use the MRS Service Program (Web Admin
Interface Server).
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PMRS Device Configuration:

The PMRS unit is based on embedded hardware/software with built-in cellular network
interfaces.
The unit must be configured prior to operation. This process includes pointing the unit’s
connection settings to the IP address of the server. Furthermore, the unit’s cellular
connection settings must adhere to those of the cellular provider in use. In particular, the
cellular provider’s APN (Access Point Name) must be provided. The unit is configured using
the Device Configurator software, by connecting a USB cable between the unit and a
computer (XP or higher).
In order for the “MRS device Configurator” to work and communicate with the unit, the
following two elements have to be installed on your PC:
1) MRS Device Configurator software.
2) MRS USB drivers.

3-2-1 MRS Device Configurator Installation:
To setup the “MRS Device Configurator Application”, follow these instructions:

1) Run the “Setup_MRS_DeviceConfig.msi” file.

2) Click “Next”.

37

May 28, 2013

INFODRAW

PMRS-102 User Manual v5.4.1

3) Click “Next”.

3) If you have an Anti-Virus
program installed on your PC
and this window appears, Click
“Run this program Anyway”.



MRS USB Drivers must be installed on your PC to allow the MRS unit configuration
program to work properly. The way of installation differs between 32bit OS and
64bit OS, the operating system version can be found through the control panel of
your computer.
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Setting up the Device for Configuration:
1) Make sure the SIM card is NOT inserted into the PMRS unit.
2) Change the 2 left dip switches (numbers 1,2 to external USB mode - up position)

3) Connect the USB cable between the unit (Mini USB Input) and your PC.
4) Turn on the unit and wait about 1 minute.
5) After a few seconds the system will show –

6) After another few seconds the system will ‘detect new hardware’.
7) For the first time connecting the unit to a PC, the PC will detect new hardware and
automatically ask for a driver. Browse for the folder where the MRS driver files are
located on your PC. Point the driver setup to Infodraw MRS Driver and install.
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Driver Installation for Windows XP, Vista, 7 (32Bit):

To setup the USB Drivers on Windows XP, Vista or 7 (32Bit), please make sure that the
device is activated with DIP switches 1 & 2 in a "down" and that you have the following two
files located in the same folder on your PC:
a) idmrs.inf
b) idmrs.sys


Sometimes the file “idmrs.inf” can only be downloaded by right-clicking the link and
pressing the “save link as…” option.

a) Right-click “my computer”.
b) Click “properties”.
c) Enter the “Hardware” tab
d) Click on “Device manager”.

When the PC is connected to a
device (With the USB cable):
a) Open the “Infodraw
Multimedia” folder.
b) Right-click on the “Infodraw
MRS Device” file.
c) Choose the “update driver”
option.
* If the device appears as an
"Unknown device" - please connect
the USB cable to another USB port or
to a USB hub until the device is
identified.
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The “Hardware Update Wizard” window will
pop up. Click “No, not this time”, then click
“Next”.

Click the “Install from a list or specific
location (Advanced)” option, and then click
“Next”.

May 28, 2013

a) Click the “Search for the best
driver in these locations”
option.
b) Tick the “Include this location
in the search” option.
c) Press the Browse button and
search for the folder where
the MRS driver files are stored
on your PC.
d) Click “OK” after you have
located the driver’s folder.
e) Then click “Next”.

After successfully installing the drivers, begin the initial configuration.
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Driver Installation for Windows 7 (64Bit):

To setup the USB Drivers on Windows 7 (64Bit), please make sure you have the following
three files located in the same folder on your PC.
Download the file MRS USB Driver.zip and extract it's content which should include:
a)
b)
c)
-

dseo13b.exe
idmrs64.inf
idmrs64.sys
All of the files should be in the X64 folder, they should be extracted to the same
folder.

Once the above three files are on your PC, follow these instructions to install the drivers:
1) Run the “dseo13b.exe” file.

Click “Next”.

Click “Yes”.
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a) Click the “Enable Test Mode” option.
b) Press “Next” and exit the program.
c) Exit the program
d) Restart your computer.

Once your computer restarts, you
should see the “Test Mode” writing
on the bottom right hand side of
your desktop screen.

Open the “dseo13b.exe” program
again and enable "Sign a System
File". Then press "Next".
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A new window will open. Fill in the
path to where the MRS driver file
“idmrs64.sys” is located on your
PC.
Then Press "OK" and exit the
program.

 If the driver setup doesn’t automatically open, follow these instructions to install the
drivers manually:

a) On your desktop, right-click
on “Computer”. Select the
“Properties” option.
b) In the “System” window,
select “Device Manager”
on the left hand side of the
screen.
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a) Open the “Infodraw
Multimedia” folder.
b) Right-click on the
“Infodraw MRS
Device” file.
c) Choose the
“Update Driver
Software” option.

If the device appears as an "Unknown Device" - please connect the USB cable to
another USB port or to a USB hub until the device is identified.
The “Update Driver Software” window will
appear. Select the “Browse my Computer for
driver software” option.

Browse your computer and choose the folder
where the MRS drivers are located. Then click
“Next”.

After successfully installing the drivers, begin the initial configuration.
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Driver installation for Windows 8 OS

If you have a Windows 8 OS please follow these instructions and then follow the installation
instructions of the 64bit OS above.
1. Press Windows Key + R
2. Enter shutdown.exe /r /o /f /t 00
3. Click the "OK" button
4. System will restart to a "Choose an option" screen
5. Select "Troubleshoot" from "Choose an option" screen
6. Select "Advanced options" from "Troubleshoot" screen
7. Select "Windows Start-up Settings" from "Advanced options" screen
8. Click "Restart" button
9. System will restart to "Advanced Boot Options" screen
10. Select "Disable Driver Signature Enforcement"
11. Once the system starts, install the Infodraw drivers as you would on Windows 7
The steps above, probably will not work unless Secure Boot has been disabled in the BIOS
before performing these steps.
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3-2-2 Initial Configuration of the MRS Device
1. After installing the drivers and activating the device in configuration mode (DIP
switches 1 & 2 raised). If the instillation was conducted properly, the settings on the
MRS device configurator should be illuminated and the log on the bottom-left side of
the program should read "Parameters Loaded".
2. Enable the "Remote Server" and type in the IP address of your server.
3. Click on the candle icon to save the changes you have made. Wait until the log in the
bottom-left reads "Parameters Saved".

4. Deactivate your PMRS device and lower DIP switches 1 & 2 to a "down" position.

5. Install the MRS Monitor-Client, follow the instructions of the MRS monitor-client section
below.
6. Activate the PMRS device.



For further reading go to the MRS device configuration section.
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MRS Monitor Client:

The MRS Monitor Client can be set up on any PC/Laptop using Windows XP or later.
To setup the “MRS Monitor Client Application”, follow these instructions:
1) Run the “Setup_MRS_Client.msi” file.

3) Click “Next”.

2) Click “Next”.

4) Click “Next” to begin installation.
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Once the MRS Monitor Client application is installed and opened, to setup the PC/Laptop to
act as a client, follow these instructions:

1) Open the “session” menu on the
top left hand side.

2) Open the “Connection” screen.

3) Select “Remote server”. Enter
the IP of the server and a
Username and Password if
required. Press “OK”.
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4) Once the client is connected to the server, the status bar on the bottom left hand side
of the window should show “Connected”.

The Client is now connected and can communicate with the server. The client has viewing
and control capabilities as defined on the server.
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Chapter 4 – MRS Software Components
4-1

MRS Monitor Client Application:

The MRS Monitor Client Application
is used for connecting to the server
to monitor and control MRS/PMRS
units. This application has all the
features of the MRS Monitor Server
Application, except it has no server
capabilities. Upon opening the
application, you will see a tree on
the left-hand side with the
following features:

Item:

Description:

Speaker is off

Configure settings for your computer’s speakers.

Microphone is off

Configure settings for your computer’s microphone.

Recordings

a) View Recorded video/audio files.
b) Configure settings for local monitor recording files.

Locations

a) View the GPS map full screen showing all connected
units on it.
b) Configure trigger actions for GPS event alarms.

Visual Motion Detection

Configure trigger actions for Visual Motion Detection
event alarms.

Contacts Alarm

Configure trigger actions for the Alarm button and GPIO
event alarms.

Online Devices

Will display all online MRS/PMRS devices.

Offline Devices

Will display all devices that have disconnected from the
server, if the device has been ticked to be remembered
by the server.

Neighbourhood

Will display information about the server you are
connected to such as: IP address, software version etc.

Communication

Displays network information.
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4-1-1 Setting Language:
The MRS Monitor Application supports 18 different languages. Follow these instructions to
change the language of the application:

1) Open the “Session” menu at
the top left-hand corner of the
screen.
2) Select “Language”.

3) The “Select Language” window
will appear. Select your desired
language. Then press “OK”.

Your selected language will now be
displayed on the MRS Monitor
screen.
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4-1-2 Connecting the Unit to the Server:
1) Insert the SIM card into the PMRS Unit.
2) Ensure the GSM/GPS Antennas are connected to the unit.
3) Ensure your server (either through the MRS Service Program Web Admin Server or
the MRS Monitor Server Application) is running and working properly.
4) If your server is running through the “MRS Service Program”, open the MRS Monitor
Client on another PC/ Laptop and connect to the server.
5) If your server is running through the “MRS Monitor Server Application”, you can
either connect to it using the MRS Monitor client on another PC/ Laptop, or you can
view the video streaming in the MRS Monitor Server Application itself.
6) Turn on the PMRS device.

Once you turn the unit on, it
should connect to the server within
1 minute.
All connected units will appear on
the left hand side of the “MRS
Monitor” screen under “Online
Devices”.

Double clicking on the PMRS device
name, will bring up a window
showing the unit’s ID number and
firmware version. Press “OK”.
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A new tree will appear under the PMRS device name on the left-hand side. The tree
contains information regarding the unit’s features as defined inside the unit. The
descriptions of the features are listed below:
Items:
Camera 1

Audio In 1

Audio Out 1

Sensors
Switches
Location

SMS

Signal

Service Type
Battery Capacity

Alive Time

Recordings

Descriptions:
a) Open/Close the Video channel of the
unit.
b) Configure settings for the Video
channel.
a) Open/Close the Audio In channel of
the unit.
b) Configure settings for the Audio In
channel.
a) Open/Close the Audio Out channel of
the unit.
b) Configure settings for the Audio Out
channel.
View the status of Input Sensors.
View the status and control Output
Switches.
a) View the GPS location of that specific
device only.
b) Set location event alarms.
Allows you to add mobile phone numbers
for SMS events, as well as determine
what events will trigger an SMS.
Displays the current signal strength for
the cellular network the unit is connected
to.
Displays the Cellular Service Type in use,
for example: HSDPA/HSUPA
Displays the unit’s remaining battery
capacity in hours and minutes. Also
displays if the unit is being charged.
Displays how long the unit has been
connected to the server in days, hours
and minutes.
Download and play recordings from the
Micro SD card inside the unit. The
Recordings folder will appear if a Micro
SD card is inserted into the unit.
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4-1-3 Viewing Video:

Before viewing the video channel, it must
be enabled. In order to enable a specific
channel, point the cursor over the channel
and right click. Alternatively open the
action menu at the top of the screen, then
select the “Enable” item.

Drag & Drop a video channel on the left hand side to the desired window to open it for live
video streaming. Alternatively, double click on a video channel to open it for live streaming.
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Double clicking on an open video stream expands the size to full screen. Double clicking
again returns it to the previous setting.

If the video looks like it is not
centred correctly, right click
on the video channel and
select “Restart Media” or
press F5 while the cursor is
on the channel. This will
restart the video channel and
centre it correctly.
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The viewing area can be split into 1, 4, 6, 9, 12, 16 or 20 viewing channels.

To change the number of channels
viewed on the screen, open the
“View” menu at the top of the
window and select the desired
number of channels.
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Video Properties:

Right clicking on an open video
stream, opens a small menu.
Select “Properties”.
Selecting a specific video
channel on the left hand side of
the screen and pressing F3
brings up the same “Video
Properties” window.

The “Video Properties”
window will appear.
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In the “Video Properties” Window you can adjust the settings of that specific video channel.
The descriptions of the settings are listed below:
Items:

Descriptions:

Enabled

Allows you to Enable/Disable the video channel

Name

Allows you to change the name of that specific video channel.

Single Encoder

When this box is ticked, that video channel will have a single encoder (Bit
Rate/ Frame Rate) for viewing/recording the video stream. When this box
is Un-ticked, this enables you to assign multiple encoders to the video
channel (one for viewing and one for recording.)

Destination

Allows you to apply settings for the multiple video encoders. Please view
the “Multiple Video Encoders” section of this manual, for more
information.

Image Size

This allows you to adjust the Image Size (Resolution) of the video channel.
The unit supports the following Image Sizes:
PAL – D1/CIF/QCIF
NTSC – D1/CIF/QCIF
Make sure that the settings are compatible to the camera you have
(PAL/NTSC), and to the bandwidth at your disposal. For example D1 (TV
quality) will require high bandwidth, CIF can be afforded with medium
bandwidth and QCIF is the format more suitable to low bandwidth.

Frame Rate

Adjust the Frame Rate of the video channel to fit the bandwidth at your
disposal. The Frame Rate can be set to any number from:
1 to 25 fps (for PAL).
1 to 30 fps (for NTSC).

Bitrate

Adjusting the Bit Rate of the video channel changes the quality of the
video, it should be set to fit your bandwidth capabilities and your cellular
package. The Bit Rate can be set to any number from 10kbit/s to 2Mbit/s.

Interlaced

DO NOT enable this feature on the PMRS-102 units.

Detect Motion

Tick this box to activate Visual Motion Detection. For more information
view the “Visual Motion Detection (VMD)” section of this user manual.

Frame Text

Tick this box to enable the frame text to be displayed on the upper-left
side of the video channel.

Sync Frames

This feature should always be disabled unless told otherwise.

Write Location

Tick this box to display the GPS Co-ordinates of the unit in the frame text.

The most important parameters when viewing the video streams are the bit rate and frame
rate. The bit rate is based on the bandwidth supported by the mobile network in the area.
The bit rate of all viewing channels must be less than the bandwidth. For example, if viewing
only 1 channel and the bandwidth is 200kb then the bit rate must be less or equal to 200kb.
The frame rate can be any number from 1 to 25/30 but in a low bandwidth environment
such as 200kb, 10 - 15 is more suitable.
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Automatic Bandwidth Control:
The unit does have automatic bandwidth control which will automatically reduce the Bit
Rate and Frame Rate of the video channel, if they are set too high for the mobile network
bandwidth.
CAUTION:
If the Bit Rate and Frame Rate are set excessively higher than the mobile network
bandwidth, this may cause the unit to disconnect from the server.

The bit rate, frame rate and other
video parameters can also be
changed using the action menu
(while the cursor is on the specific
video channel).

Data Usage:
When determining the bitrate in the video parameter please consider the SIM card package
provided to you by your cellular provider, please consider the amount of data the unit will
consume. The table below provides an example of a PMRS-102 unit’s mobile data
consumption when streaming continuously.
Bit Rate of Steaming Video Channel:
1 channel at 100kbit/s
1 channel at 200kbit/s
1 channel at 300kbit/s
1 channel at 400kbit/s

Data Usage Per Day (roughly):
1.08 GB
2.16 GB
3.24 GB
4.32 GB

Data Usage Per Month (roughly):
32.4 GB
64.8 GB
97.2 GB
129.6 GB
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Multiple Video Encoders:

The encoder is the image size, frame rate and bit rate of the video channel. By default, the
same encoder is used for viewing and recording the video channel. Different video encoders
can be applied for viewing the video channel and recording the video channel. Follow these
instructions to do so:

1) In the “Video Properties”
window, un-tick “Single Encoder”.

2) In the “Destination” list box,
select “Broadcast”.
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3) Enter in the desired “Image
Size”, “Frame Rate” and “Bit rate”.

4) In the “Destination” list box,
select “Recording”.
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5) Enter in the desired “Image
Size”, “Frame Rate” and “Bit
rate”. Once you have finished,
press “OK”.

The video encoder will now be different when viewing the video channel and when
recording the video channel.

To switch back to a single video
encoder for both viewing and
recording the video channel,
simply tick the “Single Encoder”
item in the video properties
window.
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Video Frame Text:

To activate the video frame text, tick
the “Frame Text” option, located at
the bottom-right hand side of the
video properties window. Tick the
“Write Location” option to include the
GPS Co-Ordinates of the unit in the
video frame text. Then press “Apply”.

After this option is enabled, the date/ time/ GPS Coordinates/ Motion Detection Status will
be displayed on the upper-left side of the video channel (Shown Below).
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4-1-4 Other Options:

The user can change and control the
device from the MRS Monitor:

Right clicking on a PMRS device name,
brings up a menu with the following
options:

The descriptions are listed below:

Parameters:

Descriptions:

Rename

This allows you to change the name of the PMRS device.

Properties

This will bring up the window displaying the device’s ID number and
firmware version.

Attach Audio-Video

This allows you to attach the audio channel to the video channel for
synchronised recording.

Restart Device

This option restarts the PMRS device remotely.

Set Restart Period

Determine the time interval between one restart and the next.

Restart Application

This option restarts the video controller.

Set Packet Data Size

Default is 1000 (recommended not to change this parameter).

Set Time

Select this option to set the time on the PMRS device to the current time.

Remember

This parameter can be ticked in order to move the unit’s name to the
“Offline Devices” list in case the unit gets disconnected from the server.

Add Event

This feature allows you to create a user event (custom detail) that will
appear in the events log.

Send Text Message

Send an SMS to a Cell Phone.

Media Output Streams

Not relevant for the current version

65

May 28, 2013

INFODRAW

PMRS-102 User Manual v5.4.1

4-1-5 Device Location (GPS):
The PMRS unit has built-in GPS location functionality, which transmits the position of the
unit to any connected client. To activate GPS, you need to select “Activate GPS” in the
configuration software of the unit (MRS Device Configurator).
GPS usually needs clear sky (or partially) to detect position. It takes about 30 seconds for the
unit to fully operate with GPS and GSM outside. The unit starts by searching for its position
then connects to GSM. If the unit is located inside a building without clear sky, it will
struggle to find its location. It will take about 3 minutes for the unit to give up and continue
with the rest of the system (connecting to GSM). Therefore it is better to disable GPS (using
the Device Configurator) for units operating inside a building without clear sky.

There are 2 options to view devices on the map:
1. System level - All connected devices over specified full screen map.
2. Device level - Specific device only over a small map.
The System supports Google Maps and Open Street Maps. Google Maps is the default map
used. To change to Open Street Maps, open the “View” menu and select “Maps”.

The “Select Map” menu will open. In the List box, select “Open Street Map”. Then press “OK”.
The Location screen will now be viewed using Open Street Maps.
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System Level Map:

To view the system level map,
double click on “Locations” under
“My Monitor”.

You will now be able to see all devices on one full screen map as moving icons. If there are
multiple device icons on the map, the map will not be centred.
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Device Level Map:

To view the device level map,
double click on “Location” under
a specific PMRS device tree.
You can also open this “Location”
tree to see the GPS Co-ordinates.

You will now be able to see the location of the specific device in a small map alongside any
video channels that are open. The moving icon will be centred automatically every few
seconds.
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Map Views:

The GPS map can be viewed in 4 ways.
Map View

Terrain View

Satellite View

Satellite View (with labels)

To change the view of the map,
select one out of the four options
on the top right hand corner of
the map window.
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Video Over Map:

To view a video channel over the map, click on a floating icon. A menu will appear with a
list of all that device’s video channels. Click on the desired channel to open the video
stream over the map.
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GPS Location History:

GPS Location history of all devices is stored on
any connected monitor. The location history is
stored per day and per device. You can view
the GPS location history by opening the “view”
menu and selecting “Locations History”.

The “Locations History Viewer” window will
open. The files are arranged by date. Select a
specific date in the tree. Click on a device
under the “Devices” tree to display its location
history.
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GPS Location Settings:

The Location settings include the event alarm settings and settings for recording location on
monitor. The location event alarm that can be set for each individual device is triggered
once the device moves a certain pre-set distance away from its current position on the map.
The location event trigger can be set to perform the following actions on the MRS monitor:






Beep
Display device location
View default video channel
Make a Pop-up Window appear
Play a custom sound

The unit can also send a SMS to any number of phones as a result of a location event trigger
(refer to “SMS Alerts from Device” section).
The location event trigger actions are set in the “Location Event Settings” window. Follow
these instructions:

Right click on “Locations” under
“My Monitor”. Select “Properties”

In the “Location Event Settings”
window, select the desired trigger
actions and then press “OK”.
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To activate the location event
alarm, right click on the “Location”
icon under the specific PMRS device
tree and select “Set Events”.

Tick the “Max Distance From
Point” box. Enter in the desired
maximum number of meters that
the PMRS device can move from its
current position before the alarm
is triggered. Then press “OK”

Once the Location event alarm is
activated, you will see “Distance”
under the device “Location” tree.
The location alarm will still be active
even if the GPS map is closed. Once
the distance reaches the max number
of meters, the alarm will trigger and
the pre-set trigger actions will
commence accordingly.
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Recording location on Monitor
The monitor can be set to record location and to track changes in location throughout time.

Double click on the location icon
under the Monitor tree.
* If you want the location of a device
to be recorded in your monitor
recordings enable the "Display
Locations in Media playback".

After recording on monitor, when playing the file, the recording will have a display of the location on the right
hand side.
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Device Speed Over Map:

The speed of each connected PMRS unit can be viewed over the GPS map in km/h. The
speed will only be displayed if the unit is moving.
When using Google Maps, simply hover your cursor over the floating icon on the map
(either the small map or full screen map) to bring up the device speed.
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When using Open Street Maps, open the full screen map and click on the floating icon on to
bring up the device speed.
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4-1-6 Audio
The PMRS unit supports Audio In/Out streaming to any connected client.

4-1-6-1

Computer Audio Properties:

You can change the settings of your computer’s speakers/microphone using the MRS
Monitor application.
Speakers:

Right click on the “Speaker is off”
item under “My Monitor”. Then
select “Properties”.

The “Select Audio Output
Device” window will appear.

Here you can:
a) Enable/Disable your computer’s speakers, by ticking or un-ticking the box.
b) Select from the “Device” list box, which connected speaker unit you would like to use.
c) Test that speaker unit by selecting the “Test” button.
Once you have finished, press “OK”.
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Microphone:

Right click on the “Microphone is off”
item under “My Monitor”. Then select
“Properties”.

The “Select Audio Input
Device” window will appear.
The descriptions of the
settings are listed below.

Items:

Descriptions:

“Enabled” box

Enable/Disable your computer’s microphone, by ticking or un-ticking
the box.

“Device” list box

Select from the “Device” list box, which connected microphone you
would like to use.

Signal

Use the “Signal” bar to test your microphone. If the green bar is
moving, then your microphone is working.

Detect Noise

This option enables you to not send noise below the detected noise
level. When detecting noise you must not speak and allow the
monitor to calculate the maximal noise received by the microphone.

Announcement (Disable)

If you enable this option, It means that the MRS monitor will send
everything it receives from the microphone.

Conversation (Enable)

If you enable this option, It means that the MRS monitor will only
send noise if its level is above the detected noise level.

Once you have finished, press “OK”.
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Audio Streaming:

Audio In:
Double clicking on the “Audio In 1” channel
opens the audio stream of just the Microphone
on the PMRS device to the speakers on the PC.
Double clicking again on the “Audio In 1”
channel stops the audio stream.
The PMRS unit has a built-in microphone which
can be enabled by flipping “Dip Switch 3” on
the PMRS unit to “down position”. An external
microphone can also be attached to the “Audio
Input” on the “Audio in/out splitter cable”,
included with the PMRS unit.
Ensure that you have a speakers connected to
the PC.

Audio Out:
Double clicking on the “Audio Out 1” channel
opens the audio stream of the Microphone and
speakers on the PMRS device to the speakers and
microphone on the PC. Double clicking on the
“Audio In 1” channel stops the audio stream.
Ensure that either:
a) Headphones with a microphone are attached
directly into the “Audio in/out TRRS Female
Connector” on the top of the PMRS device.

Stop Audio Stream

b) Speakers and a Microphone are attached
separately to the Audio in/out Splitter Cable,
which is then connected to the PMRS unit.

Start Audio Stream

Ensure that you have speakers and a microphone
connected to your PC.
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Unit Audio Properties:

Right click on the “Audio In 1”
channel or the “Audio Out 1”
channel and select “Properties”.
This will open the “Audio
Properties window”.

Here you can change the unit’s audio parameters:
Name: Allows you to rename the audio channel.
Sample Rate: Allows you to change the sample rate
of the audio channel. The higher the sample rate, the
better the quality of sound, but it requires more CPU
resources.
Bitrate: Allows you to adjust the Bitrate of the audio
channel. The higher the Bitrate, the better the quality
of the sound will be.
The Sample Rate/Bitrate must be the same for both
Audio Input and Audio Output channels.
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Unit Audio Controls:

You can adjust the volume of the PMRS Unit’s Audio In/Out channels in the “Controls”
window. Follow these instructions to do so:
Right click on either the “Audio In 1” channel or the “Audio Out 1” channel of the PMRS
unit. Then select the “Controls” option.

The following windows will appear:

Here you can adjust the volume (Gain
Amplifier) of the Audio Input channel
of the PMRS-102 unit.

Here you can adjust the volume
(Mono DAC) of the Audio Output
channel of the PMRS-102 unit.
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4-1-7 Recording
Recordings can be stored either inside the unit on a micro SD card (Device Recording) or on
each computer that is connected to the video stream (Local Recording). Both types of
recordings can be applied at the same time by activating them one by one. Recordings can
be viewed using either the MRS Monitor Player, MRS AV Player Application or by using VLC
player.

4-1-7-1

Local Recorder Settings

The recordings can be saved in any folder on your PC/laptop. The location of the recordings
folder on your PC/laptop, as well as other local monitor recording settings can be changed in
the “Local Recorder Settings” window. To access this settings window, right click on the
“Recordings” item on the left hand side under “My Monitor”.

Select “Properties”.
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The “Local Recorder Settings”
window will appear. The
descriptions of the “Local
Recorder Settings” are listed
below.

Items:

Descriptions:

Directory

This is the folder where all your local monitor recordings will
be stored.

Browse (button)

This button allows you to change the location of the
recordings folder on your PC to any desired location. Click to
browse for a location on your PC where you would like the
recordings to be saved.

Explore (button)

Click this button to open the recordings folder on your PC.

File Size Limit

This option allows you to setup the file size limit of local
recordings on your computer. When a recording file reaches
its size limit, the file will split and start recording in a new file.

Delete old files to free
space

If you tick “Delete old files to free space”, then the oldest
recorded files in the folder will be overwritten when the total
folder storage capacity goes under 10%.

Sign Files

Tick this option to produce a digital signature on each Local
Monitor recording file, to prove the integrity of that
recording. For more information, please view the “Recorded
Files Digital Signature” section of this user manual.

Record Locations

This option allows you to choose whether the MRS monitor
records GPS information or not.

Minimal Event Recording
Time

Determine the amount of recording time after an event is
triggered.

File Encryption

This option allows you to encrypt the recording files on your
computer with a code. For more information, please view the
“Recorded Files Encryption” section of this user manual.
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Local Recording:

To record a video channel locally on your PC/laptop, follow these instructions:
1) Select the channel that you want
to record by clicking on the channel
name under the PMRS device on the
left hand side.

2) Open the Action Menu and
enable the recording by clicking on
"Record on Monitor".

Alternatively, right click
on an open video stream
and select “Record on
Monitor”.

Repeat the same process and select “Record on Monitor” to finish the recording.
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After you enable the recording
action, the corresponding
message will appear at the top
of the video channel (“M”).
This message means that local
recording has commenced
successfully.

To view and play local recordings, open the “Recordings” tree on the left hand side of the
screen under “My Monitor”. The files are arranged by date. Choose the recorded file by
date, time, device- ID and channel name. Double click on the file to play it in the MRS
Monitor player.

Alternatively, to play recordings, locate and open the recordings folder on your PC/laptop.
The files are arranged by date. Select the desired recording. Open it in either the MRS AV
Player Application or in VLC Player.

85

May 28, 2013

4-1-7-3

INFODRAW

PMRS-102 User Manual v5.4.1

Device Recording:

To record a video channel on the Micro SD card in the PMRS device, follow these
instructions:
1) Select the channel that you want
to record by clicking on the channel
name under the PMRS device on
the left hand side.

2) Open the Action Menu and enable
the recording by clicking on "Record
on Device ".

Alternatively, right click on
an open video stream and
select “Record on Device”.

Repeat the same process and select “Record on Device” to finish the recording.
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After you enable the recording
action, the corresponding
message will appear at the top of
the video channel (“D”). This
message means that device
recording has commenced
successfully.

Once device recording is enabled, the channel will record all the time even if there is no
connection with the server. (The bit rate of the Micro SD is limited according to the
manufacturer).

There are two ways to view the device recordings:
1) Remove the Micro SD card from the PMRS unit. Insert the Micro SD into a
compatible SD adapter then insert it into a PC. Copy the files onto your PC to view
them.
2) Download the device recordings from the Micro SD card to your PC remotely over
the cellular network. To download the files remotely, follow these instructions:

When a Micro SD card is inserted into
the PMRS unit, the “Recordings” icon
will appear on the left hand side under
the specific PMRS device tree.
Open the “Recordings” tree. The files
are arranged by date and time.
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Right click on the desired recording and
select “Download”.

The recorded file will download to your
PC/laptop over the cellular network.

Once the file has downloaded
successfully, you will see this message.
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To play the file, simply locate it in the
“Recordings” tree again and double
click on it to play it in the MRS Monitor
Player.
The device recorded file will also be
saved in your recordings folder on your
PC/laptop. Alternatively, to play
recordings, locate and open the
recordings folder on your PC. The files
are arranged by date. Select the
desired recording. Open it in the MRS
AV Player Application or in VLC Player.
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Remote Server Recording:

Video/audio streams can be recorded on the server machine, remotely from any location,
using the MRS Monitor Client Application. Follow these instructions to do so:
1) Select the channel that you want
to record by clicking on the channel
name of a PMRS device that is
connected to the server.

2) Open the Action Menu and enable
the recording by clicking on "Record
on Server ".

Alternatively, right click on
an open video stream and
select “Record on Server”.

Repeat the same process and select “Record on Server” to finish the recording.
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After you enable the recording
action, the corresponding
message will appear at the top of
the video channel (“S”). This
message means that Server
recording has commenced
successfully.

The recorded files will be stored in the Server’s Local Recordings folder and can be
accessed and viewed from there. The server recordings can also be viewed from
any location, using the MRS Monitor Client Application. Follow these instructions
to do so:

1) In the MRS Monitor Client Application, open
the “Neighbourhood” tree on the left hand
side.
2) Open the “Recordings” tree. This tree
contains all server recordings. The files are
arranged by date and time.
3) Locate the recorded file you wish to view.
Double click on it to play it in the MRS
Monitor Player.
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The AV player will upload and will play the recording you have created.
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Audio Recording:

To record the audio channel on the PMRS device, follow these instructions:
1) Select the audio channel for
recording by clicking on the “Audio In
1” channel name of the PMRS device
on the left hand side.

2) Open the Action Menu and enable
the recording by clicking on “Record
on Monitor”, “Record on Device” or
“Record on Server”.

Alternatively, right click on the “Audio In
1” channel and select “Record on
Monitor”, “Record on Device” or
“Record on Server”.

Repeat the same process and select “Record on Monitor”, “Record on Device” or “Record
on Server” to finish the recording. View the audio recordings the same way as video
recordings are viewed.
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Synchronized Video and Audio Recording:
To record video and audio together, follow these instructions:

1) Select the PMRS device on the
left hand side of the screen.

2) Open the “Action” menu and
select “Attach Audio Video”.
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3) The “Attach Channels” menu
window will open. Select the video
channel from the “Video Channel” list
box.

4) Select the Audio channel from the
“Audio Channel” list box. Then Press
“OK”.

Once you record that video channel, the recorded file will have synchronised audio in it.
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SMB Recording (External Storage Device):

The PMRS unit is able to record in the device (Device Recording) on two formats:
1) On a Micro SD card, which is inserted into its slot in the device.
2) On an External Network Storage Device that can be connected to the PMRS Unit’s
LAN interface. An external network storage device, like a portable hard-drive, can
add greater recording space and allow for higher quality device recording than on
the Micro SD card. The External Network Storage Device must have an Ethernet
input for the PMRS unit to be able to connect to it. Ethernet external network
storage drives can be purchased from your local IT store.
In order to communicate with the external network storage device, a Local Area Network
needs to be created in the PMRS unit. Follow these instructions to do so:
1)
2)
3)
4)
5)
6)

Open the “Device Configurator” Application.
Turn the PMRS unit off.
Ensure the 2 left dip switches on the PMRS unit (numbers 1,2 are in up position).
Ensure the SIM card is NOT inserted into the unit.
Connect the PMRS unit to the PC using the USB Cable. Then turn it on.
Once connected to the PC, the unit’s parameters will load automatically on the
“Device Configurator”.
7) Go to the “Local Network” menu of the Device Configurator.

a) Enable the “Manual” option.
b) Enter the following
parameters of your local
network:
Host Address: 192.168.0.1
Subnet Mask: 255.255.0.0
Broadcast Address:
192.168.255.255
c) Enable the “DHCP Server”
option.
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8) Go to the “Recording” menu of the Device Configurator.

a) Under “Remote File System”, Change the “type” to “SMB” from the list box.
b) In the “Address” box, enter the address of the folder on your external network
storage device that you want the recordings saved to.
c) Enter the User Name for your storage device in the “User Name” box.
d) Enter the Password for your storage device in the “Password” box.

After inputting the above settings, the
configuration must be saved into the
unit. This is done by opening the File
menu and clicking “Write To Device”
(The candle icon).
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After pressing “Write to
Device”, the status at the
bottom left hand side of the
application will show:
“Parameters Saved”.

After the parameters are
saved, open the “File” menu
and select “Shutdown Device”.

You will then see the following
status at the bottom left-hand
side of the screen: “Device
disconnected”.

1)
2)
3)
4)
5)

You can now unplug the USB cable from the PC and the device.
Turn the PMRS device off.
Change back the left 2 dip switches (numbers 1,2 to down position).
Make sure that the Micro SD Card is NOT inserted into the unit.
Connect the Ethernet cable between the PMRS unit and the External Network
Storage Device.
6) Insert the SIM card into the PMRS unit.
7) Ensure the GSM/GPS Antennas are connected to the unit.
Once you activate the PMRS unit, you will be able to record on the External Network
Storage Device the same way as you record on the Micro SD Card (View “Device Recording”
section for more information).
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Recorded Files Digital Signature:

A digital signature can be added to the recorded video to guarantee the integrity of the files.
This can be enabled in:
1) The Device Configurator Application for “Device Recordings”.
2) The MRS Monitor server/client Application for “Local Monitor Recordings”.
As a result of enabling the Digital Signature there will be an extra file written on the same
location as the video files with the extension “.sig”.
For Device Recordings:
a) In the Device Configurator, go to the “Recording” menu tab.

b) Enable the option “Sign media files”.
c) Write to Device.

99

May 28, 2013

INFODRAW

PMRS-102 User Manual v5.4.1

For Local Monitor Recordings:
a) In the MRS Monitor Application, right click on the “Recordings” item on the left hand
side under the “My Monitor” tree. Select “Properties”.
b) The “Local Recorder Settings” will appear.

c) Enable the option “Sign Files”.
d) Press “OK”.

After you enable this option (in either the Device Configurator or the MRS Monitor) and
record a video file, the integrity of that file can be checked with the “MRS AV Player
Application”. For more information, please view the “MRS AV Player Application - Verifying
Digital Signatures” Section of this user manual below.
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Recorded Files Encryption:

The recorded files can be encrypted with a user defined encryption code.
This can be enabled in:
1) The Device Configurator Application for “Device Recordings”.
2) The MRS Monitor server/client Application for “Local Monitor Recordings”.
For Device Recordings Encryption:
a) In the Device Configurator, go to the “Recording” menu tab.

b) Tick the “Enable” box under “File Encryption”.
c) In the “Key” box, enter in your desired encryption code for Device Recordings. The
longer the code, the harder it is to break.
d) Save to the Device.
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For Local Monitor Recordings Encryption:
a) In the MRS Monitor Application, right click on the “Recordings” item on the left hand
side under the “My Monitor” tree. Select “Properties”.
b) The “Local Recorder Settings” will appear.

c) Tick the “Enable” box under “File Encryption”.
d) In the “Key” box, enter in your desired encryption code for Local Monitor
Recordings. The longer the code, the harder it is to break.
e) Then press “OK”.
After you enable your encryption code (in either the Device Configurator or the MRS
Monitor) and record a video/audio file, you will have to fill-in the defined key in the “MRS
AV Player Application” in order to view the recording. For more information, please view the
“MRS AV Player Application – Decrypting Recorded Files” Section of this user manual below.
You will also be able to view the encrypted recording files in the MRS Monitor Application, if
your encryption code is inserted in the “Local Recorder Settings” window. If you don’t want
anyone to be able to view the encrypted recordings in the MRS Monitor Application, simply
remove your encryption code from the “Local Recorder Settings” window.
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4-1-7-10 Recording History in Graphic Format:
All recordings can be viewed graphically per day and per device in the “Historic Activity”
window of the MRS Monitor Application.

Open the “View” menu and select
“Historic Activity”.

Recorded events triggered from GPIO alarms/ VMD/ location alarms, or
user events are marked as vertical lines on the graph. Every recording
can be viewed by double click on the required portion in the graph.
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4-1-8 VMD:
The PMRS unit supports VMD (Visual Motion Detection) which can be configured for
individual video channels. VMD is used to alarm viewing clients and to send SMS (refer to
the “SMS Alerts from Device” section).

VMD can be setup to trigger a variety of
actions, once motion is detected. To
configure these settings, double click on
the “Visual Motion Detection” icon on
the left hand side of the screen.

The “Visual Motion Detection Settings” window
will open. Select the desired actions that will
trigger when VMD is activated. Then press “OK”.
The descriptions of these trigger actions are
listed below.

Trigger Actions:

Descriptions:

Beep

Enable this option to cause a beeping sound on the MRS
Monitor Application, once motion is detected.

View Channel

Enable this option to cause the video channel to
automatically open for live streaming, once motion is
detected.

Close Channel After

Allows the user to determine the amount of time the
channel will be viewed after VMD is triggered.

Record Channel

Enable this option to cause that video channel to
automatically start recording on monitor, once motion is
detected.

Popup Window

Enable this option to cause a popup window to appear on
the MRS Monitor Application, once motion is detected.

Play

Use this option to play a custom sound, once motion is
detected. Click the “Browse” button to search for an
audio file on your PC. (.wav, .mp3, .wma formats are
supported.)
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To activate VMD on a video channel, follow these instructions:

Right click on an open channel’s
video stream and select properties.

In the “Video Properties”
window, select “Detect Motion”.
Then press “OK”

Under the video channel’s name, the
following message will appear: “No
motion detected”. This means VMD is
now activated.
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Once there is motion past the camera,
the following message will appear under
the video channel’s name on the left
hand side of the screen: “Motion
Detected!”

Motion Detection will still be active even if the video channel is closed. Once motion is
detected, the trigger actions predefined in the VMD settings menu will commence
accordingly.

When VMD is triggered, the
settings that were previously set
for VMD in the MRS Device
Configurator (Device), Monitor and
MRS Service, are carried out.
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4-1-8-1 VMD Configuration
To configure the VMD, enter the properties menu after right-clicking.

Output Port: in order to activate a
switch when VMD is triggered
change the Output port to the
switch you choose to activate and
change the Detection value to 1.

Internal Rectangle: To create a
limited space when motion could be
detected, manually draw a
rectangle, on the video channel and
click on the "Internal rectangle" box.

Manual Threshold: enabling the
manual threshold, allows manual
change of the VMD sensitivity on a
spectrum. To carry out this action
fill the "Manual" box.
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4-1-9 GPIO (Sensors and Switches):
The PMRS unit has 5 input and 4 output ports. The GPIO ports are at TTL level. The GPIO
connections are built in to the PMRS unit. The first input port is the alarm button which is
imbedded in the side of the device. The rest of the ports are reachable through the
GPIO/PTZ cable wires (for colour definitions refer to the “GPIO/PTZ Cable” section of this
user manual).
The GPIO ports can be set up to trigger a variety of alarms including live video streaming,
video/audio recording, GPS tracking etc. These features are set on the MRS monitor. The
unit can also send a SMS to any number of phones as a result of a GPIO trigger (refer to the
“SMS Alerts from Device” section of this user manual).
The GPIO trigger actions are set in the “Alarm Settings” window of the MRS Monitor. Follow
these instructions:

Double click on the “Contacts
Alarm” item on the left hand
side of the screen under “My
Monitor”.

The “Alarm Settings” window
will open. Select the desired
actions that the GPIO ports will
trigger when activated. Then
click “OK”.
The descriptions of these
trigger actions are listed below:
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GPIO Trigger Actions:

Descriptions:

Beep

Enable this option to cause a beeping sound
on the MRS Monitor Application, once a
GPIO alarm is activated.

Display Device Location

Brings up the unit location on the GPS map,
once a GPIO alarm is activated.

View Default Video Channel

Enable this option to cause the video
channel of the PMRS unit to automatically
open for live streaming, once a GPIO alarm is
activated.

Record Default Video Channel

Enable this option to cause the video
channel to automatically start recording,
once a GPIO alarm is activated.

Record Default Audio Channel

Enable this option to cause the audio
channel of the PMRS unit to automatically
start recording, once a GPIO alarm is
activated.

Popup Window

Enable this option to cause a popup window
to appear on the MRS Monitor Application,
once a GPIO alarm is activated.

Play

Use this option to play a custom sound on
the MRS Monitor Application, once a GPIO
alarm is activated. Click the “Browse” button
to search for an audio file on your PC. (.wav,
.mp3, .wma formats are supported.)
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Output switches: The PMRS unit has 4 GPIO Output Switch ports. External peripheral
devices (such as alarms, external sirens etc.) can be connected to these output ports and
then set to trigger a variety of actions once activated. The GPIO Output Switch ports are at
TTL Level.
To connect peripheral devices to the Output Switch Ports on the PMRS unit, you must close
a connection between the following wires on the “GPIO/PTZ cable”:
Port 1)
Port 2)
Port 3)
Port 4)

Output 1 wire and GND wire.
Output 2 wire and GND wire.
Output 3 wire and GND wire.
Output 4 wire and GND wire.

ON/OFF switching of these ports is done in the “MRS Monitor Application”. Follow these
instructions:

The statuses of the Output signals are
viewed in the PMRS device tree on the
left hand side under “Switches”.
Switch 1 = Output 1
Switch 2 = Output 2
Switch 3 = Output 3
Switch 4 = Output 4
Double click on a “Switch number” to
turn it ON/OFF.
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4-1-10 SMS Alerts From Device:
The unit can send a SMS alert to any number of mobile phones as a result of a VMD trigger,
GPIO trigger or a location event trigger. Messages can be written in any language. The
contact details must be supplied in the SMS settings window, located on the left hand side
of the screen. Follow these instructions to activate SMS alerts:

Open the “SMS Settings” window
by double clicking on the “SMS”
item on the left hand side under
the PMRS device tree.

In the “SMS Settings” window,
firstly select the “Enable” option
on the top right hand side. This
will enable SMS alerts from that
PMRS device.
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Under “Events” select the desired
triggers from which an SMS will be sent.
Contact Alarm = GPIO events
Motion Detection = VMD events
Location Events = GPS events

In the “Common Message”
box, write a message that you
would like to receive on your
mobile phone. Once you have
finished, click “Apply”.
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Insert a “Name” and “Phone
Number” at the bottom of the
window.
If you own a Smartphone,
enable the “Send Image”
option to attach a still-picture
of the video stream to the SMS.
Once the details are inserted,
press the “Add” button to add
the mobile to the list. Repeat
the process to add another
mobile.

Your new name and phone
number will appear in the list
box. To delete a mobile
number, select the name and
press the “Delete” button.
Once you have finished, click
“Apply” and then click “Close”.

SMS alerts are now activated. A SMS will now be sent to the assigned mobile phone(s) as a
result of any trigger defined in the “SMS Settings”.
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4-1-11 Photo Snapshots:
Photo stills can be taken of any open video stream on the MRS Monitor Application. Follow
these instructions to do so:

Right click on an open video
stream and select “Save Image”.

This will save an image of the video stream in .jpeg format to your local recordings folder.
You can access and view the images the same way video recordings are viewed. Follow
these instructions:
Open the “Recordings” tree on the
left hand side under “My Monitor”.
Double click on the desired saved
image to open it.

The image will then open in Windows Photo Viewer.
Alternatively, to view the saved image, locate you
recordings folder on your PC and double click on the
image file to open it.
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4-1-12 Session:
A session is set of parameters which defines the current state of the MRS monitor
application. A session includes any open channels and channel parameters. A session can be
saved to a file and reloaded at any time. To do so, open the “Session” menu and select
“Save As”.

Users can enable the “Automatic” button
in the “Session” menu which will save
the current settings of the last session
when exiting the program. After
restarting, the program will load the last
updated session which was saved
automatically when exited.
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4-1-13 Neighbourhood:

In the MRS Monitor Server Application:
In the MRS Monitor Server Application,
the user can view details of all
connected MRS/PMRS devices and
clients under the “Neighbourhood”
tree. The details include IP addresses,
Software Versions and Tolerance (CT).

In the MRS Monitor Client Application:
In the MRS Monitor Client Application,
the user can view details of the server
under the “Neighbourhood” tree. The
details include the IP address, Software
Version and Tolerance (CT).
You can also access the server’s
recordings folder by double clicking on
the “Recordings” tree.
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4-1-14 Communication:
The communication node allows users to see their available connections: Bluetooth, Local
area, wireless and its loopback (computer ID).
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MRS AV Player Application:

The MRS AV Player Application is used for viewing recorded video/audio files, verifying
digital signatures on recorded files and decrypting recorded files.
1) Run the “Setup_MRS_AV_Player.msi” file.

3) Click “Next”.

2) Click “Next”.

4) Click “Next” to begin installation.
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4-2-1 Playing Recorded Files:
There are three formats that recorded files are saved in:
Recording Type:
Format:
Video
H264
Audio
AAC
Synchronized Video and Audio
FLV
 If you want to convert H264 file to a FLV file (which is identifiable to most players),
open the "file" menu and click on the "Export FLV" option.
Once the MRS AV Player is installed and opened, follow these instructions to play recorded
files:
1) Open the “File” menu and
select “Open”.

2) Browse your PC for the recordings folder. The
recorded files are arranged by date and time.
Select the desired recording. Then press “Open”.

3) The Recorded file with then
commence playing in the
MRS AV Player.
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The recording playback can be
speeded up or slowed down. To do
so, open the “Effects” menu and
select “Speed”.

The “Set Playback Speed” window
will appear. The descriptions of the
settings are listed below:

Settings:

Descriptions:

Original Speed

Enable this option to keep the recording at
its normal speed.

Faster

Enable this option to speed the recording
playback up. In the list box, select how fast
you want the recording to speed up. Choose
from: x2, x3, x4, x6, x8, and x10.

Slower

Enable this option to slow the recording
playback down. In the list box, select how
slow you want the recording to slow down.
Choose from: /2, /3, /4, /6, /8, and /10.

After you have finished, press “OK”. The recording playback will now speed up or slow down
accordingly.
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4-2-2 Verifying Digital Signatures:
The digital signature authenticates the recording as one that was recorded by the MRS
system (a MRS/PMRS device, an MRS Monitor application or a MRS Service). If a digital
signature has been assigned to a recorded file, it can be verified in the MRS AV Player
Application. Follow these instructions:
Once the recorded file is opened in the MRS AV Player, open the “Misc” menu and select
“Verify Signature”.

This will result in a message “Signature Accepted (OK)” or “Signature Rejected (BAD)”
Signature Accepted means that the AV Player authenticated the recorded file as part of the
MRS system successfully.
Signature Rejected means that the AV Player did not authenticate the recorded file as part
of the MRS system successfully.

121

May 28, 2013

INFODRAW

PMRS-102 User Manual v5.4.1

4-2-3 Decrypting Recorded Files:
If a recorded file is encrypted with a code, it must be decrypted in the MRS AV Player before
you can view it. Follow these instructions to do so:
Once the recorded file is opened in the MRS AV Player, open the “Misc” menu and select
“Decryption”.
The “Decryption” window will appear. In the “Key” box, enter in your encryption code for
that recording. Then press “OK”.

You will now be able to view that recorded file in the AV Player.
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MRS Device Configurator Application:

1) After the MRS USB driver installation is complete, open the Device Configurator
application. This program allows you to configure the unit through the USB cable.
2) Turn the PMRS unit off and then back on.
3) Once the unit reconnects to the PC, it will automatically load the unit’s configuration
parameters on the Device Configurator application.

This application communicates
with the unit and has a menu
with the following options:
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4-3-1 Device Identification Menu:

Device Identification Parameters:

Descriptions:

Software Version

This is the current version of the PMRS unit’s firmware.

Device Name

This is the name of the PMRS device that will appear when
connected to the server/clients. This can be changed to any
desired name.

Device ID Number

This is the ID Number of the PMRS device that will appear
when connected to the server/clients. This can be changed
to any number above 0 and below 2 billion. Ensure that
each PMRS unit that is connecting to the same server has a
Unique ID Number.

Device Client Password

If a PMRS device ID has been assigned a password in the
permissions feature of the server, the password will need to
be inserted here; otherwise the unit will not be able to
connect to the server.

Hardware Identifier

This is the hardware ID number of the PMRS unit.

Modem IMEI

This is the Identifier number of the PMRS unit’s modem.

Config Password

A password can be inserted here to prevent non-authorized
people from accessing the device’s parameters through the
USB cable. Upon connecting the PMRS unit to the Device
Configurator, the Config Password will be required to
continue.

Server Admin Password

This password is for the Web Admin Interface Server
program if the PMRS device is acting as the server itself.
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4-3-2 Connection Menu:

Connection Parameters:

Descriptions:

No server

If the “No server” option is checked, the PMRS unit will not
connect to anything.

Remote server IP

Here you can update the IP address of your server, in the
“Remote server” IP box.

Secure

If your PMRS unit has secure session IPSEC Encryption
applied to it in the licensing menu, you must tick the
“Secure” option to activate the encryption.

Tolerance

Keep this option set to “High”.

Local server

The PMRS unit can also act as a server by selecting the
“Local server” option. However for this configuration, the
unit will require a SIM card with a fixed, public IP address
which must be obtained from your cellular provider.

Connection Reference (TCP)

Do not enable this feature at this time.

Timeout

This feature should be enabled (both “Maximal idle time”
and “Device Reset”). It is designed to detect an idle time
during which there is no client/server communications.
When this idle time passes, the device will reset its modem
connection. If there is no active modem and you have
enabled the reset option, it will restart itself.

ODF

This feature should be disabled, unless you are an ODF
integrator. It allows you to integrate ODF cameras into the
PMRS System.
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Connection Menu (continued):

Connection Parameters:
Multiple Connections

Descriptions:
This feature allows the connection of the PMRS device to
connect to more than one server at activation. Enable the
“Multiple Connections” option and press the “Manage”
button to open the “Multiple Connections Window”.
In the “Multiple Connections Window”, press on the “Add”
button to insert another server to which the PMRS device
will connect to.
The “Local Server” option allows the PMRS unit to act as
one of the multiple servers. Tick to enable this option.
The “Share Devices Among Servers” option shares all the
devices that are connected to the same network as this
device is, among all the servers which have been added to
the list. Tick to enable this option.
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4-3-3 Modem Menu:

Modem Parameters:

Descriptions:

None

This option turns the wireless cellular modem off.

Manual

This option allows you to configure the settings of the cellular
provider in use manually.

Automatic

This option provides automatic settings of the cellular provider in
use.

Hardware

Keep this parameter the same (set to Automatic).

Dial String

Keep this parameter the same.

APN

The Access Point Name (APN) of your cellular provider must be
entered in this box.

User Name

Here you can enter your User Name for your cellular provider if
required (usually is not required).

Password

Here you can enter your Password for your cellular provider if
required (usually is not required).

Authentication

Keep this parameter the same (set to Any), unless told otherwise
by your cellular provider.

Extra Command

This feature allows you to give the modem additional commands.
For example you can tell the modem to only search for one
cellular frequency band. To add an extra command, click the “+”
button. Enter the correct lines of code, which is obtained from
Infodraw or your local Infodraw dealer. Then press “OK”

Enable Sierra CnS

DO NOT enable this option on PMRS-102 devices.
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4-3-4 Local Network Menu:

Local Network Parameters:

Descriptions:

None

This option disables the PMRS unit’s LAN interface.

Automatic: DHCP Client

This option enables the LAN interface and makes the PMRS
unit an automatic DHCP Client for your local network. For
more information, view the “LAN” section of this user
manual.

Manual (Manual Configuration)

This option also allows you to create your own local
network which comes in handy when trying to connect to
an external hard drive or use the PMRS device as a router.
For more information, view the “SMB Recording (External
Storage Device)” section of this user manual.

Enable DHCP Server

When the “Manual” option is selected, tick the “Enable
DHCP Server” option to turn the PMRS device into a 3G
Router. For more information, view the “Use the PMRS
Device as a 3G Router” section of this user manual.
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Connect Through LAN

Follow these instructions to set up the LAN function on the PMRS:
1) Open the “Device Configurator” Application.
2) Turn the PMRS OFF.
3) Ensure the 2 left dip switches on the PMRS unit (numbers 1,2 are in up position).
4) Ensure the SIM card is NOT inserted into the unit.
5) Connect the PMRS unit to the PC using the USB Cable. Then turn it on.
6) Once connected to the PC, the unit’s parameters will load automatically on the
“Device Configurator”.
7) Go to the “Local Network” menu on the left hand side. Under the “Address
Configuration Method” menu, select “DHCP”.
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.

After inputting the above settings, the
configuration must be saved into the
unit. This is done by opening the File
menu and clicking “Write To Device”
(The candle icon).

After pressing this key, the status at the bottom left hand side of the application will show:
“Parameters Saved”.

After the parameters are
saved, open the “File” menu
and select “Shutdown Device”.
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You will then see the following
status at the bottom left-hand
side of the screen: “Device
disconnected”.

8) You can now unplug the USB cable from the PC and the device.
9) Turn the PMRS device off.
10) Change back the left 2 dip switches (numbers 1,2 to down position).
11) Connect the Ethernet cable to the PMRS unit.
You can now connect the Ethernet cable to any local network router and connect to the
MRS server using the internet.
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PMRS Device as 3G Router:

The PMRS unit can act as a 3G Router. Follow these instructions for setup:
1) Connect the unit to the “Device Configurator”.
2) Go to the LAN menu.
3) Select “Manual”.

4) Enter in the following settings:
Host Address: 10.0.0.1 or 192.168.0.1
Subnet Mask: 255.0.0.0 or 255.255.0.0
Leave the rest of the settings blank.
5) Tick the “Enable DHCP Server” option.
6) Select File>Write to Device.
7) Select File>Shutdown Device.
8) Disconnect the device and turn off.
9) Flip Dip Switches 1,2 to Down position.
10) Insert the SIM Card.
11) Ensure the GSM Antenna is connected to the unit.
12) Connect the Ethernet cable to the unit.
13) The PMRS unit will now act as a 3G Router. You can connect it to a laptop/PC
through the Ethernet cable and you should be able to connect to the internet.
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4-3-5 Wireless LAN Menu:

Wireless LAN Parameters:

Descriptions:
The PMRS-102 Unit does not support Wireless LAN (Wi-Fi).
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4-3-6 SIM Menu:

SIM Parameters:

Descriptions:

PIN

Here you can update the PIN numbers for the SIM card in
use. Some SIM cards require a PIN number but most don’t.
The PIN number is obtained from your cellular provider.

PUK

Here you can update the PUK numbers for the SIM card in
use. A PUK number will only be required if your SIM card is
locked (which can happen for various reasons). If your SIM
card does not work, ask your cellular provider if the SIM
card is locked and how to unlock it.
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4-3-7 SMS Menu:

SMS Parameters:

Descriptions:

Connection SMS Number

This feature is good for when using the PMRS device as a
server with a variable external IP address given by the
cellular provider. Every time the device connects to the
cellular network, it will send an SMS to this phone number
containing the new IP address.

Send Service Type

This is a parameter defining the technology used for
sending SMS messages. It depends on the cellular service
provider. Keep this setting the same (set to Circuit
Switched), unless told otherwise by your cellular provider.

Authentication Code

This is the code which will be required when sending
commands to the PMRS device by SMS. For more
information, refer to the “Sending SMS Commands to
Device” section of this user manual.
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Commands can be sent to the PMRS unit (SIM Card Number) remotely by SMS. There are 3
orders that can be sent:
1) Restart modem (PPP)
2) Reset device
3) Change Server IP
In order to make these operations happen, follow these instructions:
a. Remove any SIM card from the PMRS device.
b. Attach a USB cable to the device and open the “MRS Device Configurator”.
c. Open the “SMS” tab menu.
d. In the “Authentication Code” box, write down a code. You will need to put this code at
the start of each SMS to the PMRS device.

As was said above, there are three options to this feature.
These are the ways to activate each of them by SMS to the device:
1. Restart PPP: Authentication_Code restart ppp
For the above device example, the SMS would be: 76D restart ppp
2. Reset Device: Authentication_Code reset device
For the above device example, the SMS would be: 76D reset device
3. Change Server IP: Authentication_Code "server" New_Server_IP
For the above device example, the SMS would be: 76D server 212.68.105.7
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4-3-8 GPIO Menu:

GPIO Parameters:

Descriptions:

Port Selection

Here you can change the settings of the Input Sensors that
are connected to your device. The Input ports are at TTL
level. Start by selecting one of the ports. Port number 1 is
the built-in alarm button. The rest are connected to the
GPIO/PTZ cable.

Port Name

Here you can change the name of the input sensor to any
desired name.

Not Active

This option will disable the selected port.

Normally Close

This option changes the selected input port to Active High.

Normally Open

This option changes the selected input port to Active Low.

Associated Camera

This option allows you to add or remove the camera for the
selected port.

Associated Microphone

This option allows you to add or remove the microphone
for the selected port.

Record Video

Enable this option to record video on a Micro SD card inside
the device, once an alarm button/ GPIO alarm is triggered.

Record Audio

Enable this option to record audio on a Micro SD card inside
the device, once an alarm button/ GPIO alarm is triggered.
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The PMRS unit has 4 GPIO Input Sensor ports. External peripheral devices (such as alarms,
motion/impact sensors etc.) can be connected to these Input ports and then set to trigger a
variety of actions once activated. The GPIO Input sensor ports are at TTL Level. The Input
Sensors can be set to either “Active High” or “Active Low” in the “Device Configurator
Application”. Follow these instructions to do so:
1)
2)
3)
4)
5)
6)

Open the “Device Configurator” Application.
Turn the PMRS unit off.
Ensure the 2 left dip switches on the PMRS unit (numbers 1,2 are in up position).
Ensure the SIM card is NOT inserted into the unit.
Connect the PMRS unit to the PC using the USB Cable. Then turn it on.
Once connected to the PC, the unit’s parameters will load automatically on the
“Device Configurator”.
7) Go to the “GPIO” menu of the Device Configurator.

8) Select the Input Port Number.
9) Enable either the “Normally open” or “Normally Close” option.
Settings:
Normally Open
Normally Close

Descriptions:
Active Low
Active High
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After inputting the above settings, the
configuration must be saved into the
unit. This is done by opening the File
menu and clicking “Write To Device”
(The candle icon).

After pressing “Write to
Device”, the status at the
bottom left hand side of the
application will show:
“Parameters Saved”.

After the parameters are
saved, open the “File” menu
and select “Shutdown Device”.

You will then see the following
status at the bottom left-hand
side of the screen: “Device
disconnected”.

1)
2)
3)
4)
5)

You can now unplug the USB cable from the PC and the device.
Turn the PMRS device off.
Change back the left 2 dip switches (numbers 1,2 to down position).
Insert the SIM card into the PMRS unit.
Ensure the GSM/GPS Antennas are connected to the unit.

Once you activate the PMRS unit, the Input sensors will be at TTL “Active high” or “Active
Low” as defined in the Device Configurator.
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In order to trigger an Input signal you need to close a connection between the following
wires on the “GPIO/PTZ Cable”:
Port 1)
Port 2)
Port 3)
Port 4)

Input 1 wire and GND wire.
Input 2 wire and GND wire.
Input 3 wire and GND wire.
Input 4 wire and GND wire.

The statuses of the Input signals are
viewed in the PMRS Device tree on the
left hand side under “Sensors”.
Sensor 1 = Alarm Button
Sensor 2 = Input 1
Sensor 3 = Input 2
Sensor 4 = Input 3
Sensor 5 = Input 4

Once an Input Sensor is triggered, the “Sensor number” signal on the left hand side will light
up. The pre-set trigger actions will also commence accordingly. If you selected recording as a
trigger action, the message/s “M” “D” will appear at the top right hand side of the video
stream.
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4-3-9 Recording Menu:

Recording Parameters:

Descriptions:

Enable File System Optimizations

This feature should always be disabled unless told otherwise.

Verify Writes

This feature should always be disabled unless told otherwise.

Record when motion detected

This option allows you to choose whether the unit records when
motion is detected or not.

Delete old files to free space

This option automatically deletes old recording files on the Micro
SD, when the remaining storage capacity reaches below 10%.

Sign media files

Tick this option to produce a digital signature on each Micro SD
card recording file, to prove the integrity of that recording. For
more information, please view the “Recorded Files Digital
Signature” section of this user manual.

Record Locations

This option allows you to choose whether the unit records GPS
information or not.

File Encryption

This option allows you to encrypt the recording files on the Micro
SD with a code. For more information, please view the “Recorded
Files Encryption” section of this user manual.

File Size Limit

This option allows you to setup the file size limit of recordings on
the Micro SD card. When a recording file reaches its size limit, the
file will split and start recording in a new file.

Remote File System

The “SMB” option is for recording on external storage devices. For
more information, please view the “SMB Recording (External
Storage Device)” section of this user manual. The “NFS” option
should always be disabled unless told otherwise.
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4-3-10 GPS Menu:

GPS Parameters:

Descriptions:

Activate GPS

This option allows you to enable/disable the GPS capability.

Reset GPS

This option, if enabled, resets the GPS every time the
system shuts down, thus clearing the unit's memory of old
satellite information.
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4-3-11 PTZ Menu:

PTZ Parameters:

Descriptions:

Add

Here you can setup the PTZ control of the PMRS unit. Press
the “Add” button to add the “Video Channel” and “Camera
ID”. As the PMRS unit only has one video channel, set the
“Video Channel” and “Camera ID” both to 1.

Baud Rate

This list box allows you to set the PTZ control Baud Rate.
The unit supports the following Baud Rates:
1200/ 1800/ 2400/ 4800/ 9600/ 19200/ 38400/ 57600/
115200/ 230400
The Baud Rate must be set the same for the PMRS unit and
for the PTZ Camera.
For more information, please view the “PTZ” section of this
user manual.
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The PMRS system supports PTZ control. The user can control the Pan/Tilt/Zoom of the PTZ
camera according to its ability. The PMRS system supports PTZ cameras using PELCO D and
Visca Protocol. Follow these instructions to setup PTZ control:
1)
2)
3)
4)
5)
6)

Turn the PMRS device OFF.
Remove any SIM card from the PMRS device.
Ensure the 2 left dip switches on the PMRS unit (numbers 1,2 are in up position).
Attach a USB cable to the device and open the “MRS Device Configurator”.
Turn the unit on.
In the Device Configurator, Open the “PTZ” tab menu.

7) Click the “Add” button to add the “Video Channel” and “Camera ID”. As the PMRS
unit only has one video channel, set the “Video Channel” and “Camera ID” both to 1.
8) Set the PTZ Baud Rate from the “Baud Rate” list box. The system supports the
following Baud Rates: 1200/ 1800/ 2400/ 4800/ 9600/ 19200/ 38400/ 57600/
115200/ 230400.
9) Save the configuration to the device by selecting File>Write To Device.
10) After you see the message “Parameters saved” at the bottom of the screen, select
File>Shutdown Device.
11) After you see the message “Device disconnected” at the bottom of the screen, turn
the PMRS device OFF, unplug the USB cable and flip the 2 left dip switches on the
PMRS unit (numbers 1,2 ) to down position.
12) Insert the SIM card. Ensure the GSM/GPS Antennas are connected to the unit.
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After you have configured the PTZ settings of the PMRS unit in the Device Configurator, the
same settings must be applied to the PTZ camera itself. On the PTZ camera, set the ID
number to 1 and the Baud Rate to the same rate as you set the unit as.
There are 2 RS-485 wires (T+ and T-) built into the PMRS unit through the GPIO/PTZ Cable
(Refer to “GPIO/PTZ Cable” section for colour definitions). These wires must be connected
to the PTZ camera.
Once you have connected the PTZ camera, open the MRS Monitor Application and turn the
unit ON.

When you open the PTZ or Zoom
camera video channel, PTZ control
will automatically open on the
bottom left hand side of the
screen.

Use the yellow ball to move the
camera around.
To zoom in and out, use the “Zoom
in” and “Zoom out” buttons.
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Camera positions can be saved as presets for future viewing. Follow these instructions:

Move the camera to the desired
position using the yellow ball.
Enter in a name for that position in
the “Name” box. Then press
“Save”.

To view the pre-set camera
position, choose the pre-set
name from the "Move to" list
box. The camera will then
automatically adjust its position
to the pre-set.

The duration scale is to simulate
the time of one click. Moving the
duration scale up or down will
lengthen or shorten the PTZ
duration command accordingly.
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4-3-12 Licensing Menu:

Licensing Parameters:
Add License

Descriptions:
Here you can add licenses to the PMRS unit. For example: A
secure session IPSEC Encryption License, to secure all the
transmitted data from the unit to the server/clients.
To add a license click on the “Add License” button. The
“License Text” window will appear. Insert the license code
that you have received. Then press “OK”.
If the Encryption License code is correct, it will then be
listed in the licenses list (shown below). For more
information about IPSEC Encryption licenses, please view
the “Secure Session IPSEC Encryption” section of this user
manual.

Remove License

To remove a license, select it from the list and press
“Remove License”.
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If Secure Session IPSEC Encryption is activated, all the data streaming between the PMRS
unit, the MRS Server and the MRS Clients will be securely encrypted. A license is required
for each unit you wish to encrypt. If you purchased a unit with encryption, the encryption
license will already be activated. If you want to activate encryption on an existing unit that
you already have, you will need to get an encryption license code. The license code is based
on the ‘Hardware Identifier number’ of your unit. Speak to your local Infodraw dealer about
obtaining Encryption License codes. To activate the encryption, follow these instructions:
1) Go to the ‘Licensing’ menu tab on the left hand side.

2) Click on the “Add License” button.
3) In the “License Text” window, enter in the encryption license code you have received
from your local Infodraw dealer. Then press “OK”.
4) If the code is correctly entered, the “IPSEC” encryption will be listed as “Active”.
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5) Once the license in ‘Active’, go to the “Connection” menu tab of the “Device
Configurator”.

6) You will now be able to tick the “Secure” box. Tick this “Secure” box to encrypt the
data streaming from the unit to the server.

After inputting the above settings, the
configuration must be saved into the
unit. This is done by opening the File
menu and clicking “Write To Device”
(The candle icon).

After pressing “Write to
Device”, the status at the
bottom left hand side of the
application will show:
“Parameters Saved”.
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After the parameters are
saved, open the “File” menu
and select “Shutdown Device”.

You will then see the following
status at the bottom left-hand
side of the screen: “Device
disconnected”.



When connecting to the server from the “MRS Monitor Client Application”. In the
connection window, tick the “Secure” box before you connect. This will encrypt all
the data between the MRS Server and the MRS Client.
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4-3-13 Upgrade Menu

Upgrade Parameters:

Descriptions:
Here you can upgrade the unit’s firmware. Use external power and not
just battery power when upgrading the unit. DO NOT INTERUPT THE
UPGRADE PROCESS.

“Browse” button

If the upgrade file is stored on your PC, click “Browse”. Locate and
select the PMRS upgrade file (pmrs-A_B_C_D.tgz) on your PC. Then click
“Program”.

“Program” button

Click “Program” to commence upgrading the firmware. Once the unit is
finished programming, click “Restart Device”. Once the device
reconnects to the Device Configurator, it should now be upgraded to
the new version.

“Download” button

Click the “Download” button to automatically download the latest
PMRS firmware version file. Once the file is downloaded, it will
automatically prompt you to commence programming. Click
“Program”. Once the unit is finished programming, click “Restart
Device”. Once the device reconnects, it should now be upgraded to the
new version.

Automatic Restart

If the “Automatic Restart” box is ticked, the unit will automatically
restart itself once programming has finished. It is recommended to
keep this box ticked.

“Restart Device” button

This button restarts the PMRS device.

Restart Period

Filling in the "Restart period" details will make the device restart at set
intervals - is useful when the device tends to stop working during long
periods of activation.
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The MRS/PMRS unit’s firmware can be downloaded and automatically upgraded into the
unit using the “Device Configurator Application”. To do so, follow these instructions:
1) Open the “Device Configurator” Application.
2) Turn the PMRS unit OFF.
3) Ensure the 2 left dip switches on the PMRS unit (numbers 1,2) are in up position.
4) Ensure the SIM card is NOT inserted into the unit.
5) Connect the PMRS unit to the PC using the USB Cable. Then turn it on.
6) Once connected to the PC, the unit’s parameters will load automatically on the
“Device Configurator”.
7) Go to the ‘Upgrade’ section and click the ‘Download’ button.

8) A newer version (if available) of the
unit’s firmware will automatically
download.
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4) Once the firmware has been
downloaded, a pop-up will appear
asking you to commence programming.
Click ‘OK’

5) The firmware programming will
commence. DO NOT interrupt the
programming. Ensure that the unit
is being charged when upgrading
the firmware. Once completed, the
unit will automatically restart.
When the unit reloads on the
Device Configurator, it will be
upgraded to the new firmware
version.
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4-3-14 Log Menu:

Log Parameters:
Log Menu

Descriptions:
Here you can log information while running.
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For ordinary initial setup of the PMRS unit, usually you will only need to change the
following parameters in the Device Configurator:
Menu:

Parameter:

Connection Menu

a) Your server’s IP address in the “Remote Server” box.

Modem Menu

For Automatic Modem Setup:
a) Click the “Automatic” option under “Modem Configuration”.
The Automatic option supports most cellular provider APN’s
around the world. In most cases this will provide an automatic
connection to the cellular network in use.
For Manual Modem Setup (click the “Manual” option):
a) Enter the APN (Access Point Name) of your Cellular Provider.
b) A User Name and Password for your Cellular Provider may
also be required (mostly for VPN users).

SIM Menu

a) A PIN number may or may not be required for your SIM card.
b) A PUK number may or may not be required for your SIM card.
Please speak to your local Infodraw dealer or cellular provider for
specific network connection requirements.

After inputting the necessary settings
using the Device Configurator application,
the configurations must be saved into the
unit. This is done by opening the “File”
menu and clicking “Write to Device” (The
candle icon).

After pressing “Write to
Device”, the status at the
bottom left hand side of the
application will show:
“Parameters Saved”.
155

May 28, 2013

INFODRAW

PMRS-102 User Manual v5.4.1

After the parameters are
saved, open the “File” menu
and select “Shutdown Device”.

You will then see the following
status at the bottom left-hand
side of the screen: “Device
disconnected”.

1) You can now unplug the USB cable from the PC and the PMRS device.
2) Turn the PMRS device off.
3) Change back the left 2 dip switches (numbers 1,2 to down position as shown).

This will allow normal cellular operation.
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MRS Service Program:

Main Menu
The web administration interface (or WAI) contains the following configuration pages:
Administrator Menu:
Login: Restarts the server program.
Change Password: Allows you to
change the password. It is important
to change the password at first
activation.
Files and Folders: Displays the use of
files and folders by the server.
Backup Settings: Allows the user to
backup and restore the server’s
settings.
Internet Protocol: Displays network
information.
Logging Menu:
Latest Messages: Displays the server’s
latest log messages – use for
debugging.
Configure: Configure the server’s
logging parameters such as how many
messages it is able to receive.
Latest events: Displays the latest I/O
and VMD detections on the server.
User/Device Access Permissions Menu:
Default Access: Configure default users and device's access to the server.
Users: Control the users list.
Devices: Control the devices list.
Default Device Access: Control the default access permitted to devices.
Default User Access: Control the default access permitted to users.
User Device Access: Control the access permitted to specific devices by specific
users.
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Clients Menu:
Management: Controls how the
server manages clients.
Traffic Summary: Displays the
incoming and outgoing data summary.
Connected Devices: Lists the devices
which are connected to the server.
Connected Users: Lists the users
which are connected to the server.
File Uploads: Lists the files which are
being uploaded from the server.

Recordings Menu:
Configure: Configures the server's
recording attributes.
Sleep management:
Configure: Setting the timing
for the sleep regiment

List: Lists the devices with video and
audio channels that are being
recorded.

Software Updates Menu:
Licensing Menu:
List: Lists server software
licenses and enables adding
and removing licenses.

Configure: Allows the user to select
the folder from which to upload the
upgrade file.
List: Lists the software update files for
clients (devices only).
Upload: Enables uploading a software
update file for clients (devices only).
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4-4-1 Administrator Menu:

Login Page:
Enter the correct administrator's password
and click on “Login”. This will take you
back to the main menu page.

Change Password Page:
To change the administrator password,
type the current password where it says
'Old password', type a new password
where it says 'New password', and retype
the new password where it says 'Retype
new password'. Then click on “Set”. This
will take you back to the main menu page.

Files and Folders Page:
The “Data Folder” is the root folder where
all other folders and files are used by the
server.
The “Parameters File” contains all server
parameters in XML format.
The “Recordings” folder contains all server
media recordings and device locations.
The “Software Updates” folder contains all
software update files to be sent to clients
(devices only).
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Backup Settings Page:
This page will help you save the server
parameters file someplace else for backup.
Click where it says “Click Here” to display
the XML parameters file. It is then possible
to save it.
If necessary, upload the backup XML file
using the “Browse” and “Upload” buttons.
This action will restore back the settings to
the ones when you just saved the XML file.

4-4-2 Logging Menu:

Latest Log Messages Page:
This page will let you view the server's
latest log messages. It displays the time
(and date), the message, and its
parameters. Click on “Refresh” to refresh
this page. Click on the “Main Menu” link to
go back to the main menu page.

Configure Logging Page:
This page will let you change the logging
parameters.
The maximal number of messages is the
maximal number of messages to be kept in
memory.
The minimal log severity is the minimal log
severity to be displayed and kept in
memory. Log messages less severe than
this one will be ignored. Log severities are:
Undefined, Status, Warning and Error.
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4-4-3 User/Device Access Permissions Menu:
The MRS Service allows the server to decide which devices and users will be allowed access
to the server, and what level of access they will enjoy.
There are 5 different access levels: Administrative, Active, Passive, Aware and Forbidden.
Here are the activities which are permitted to each of those levels:
Level of Permission/
Actions Permitted
Can view online devices &
Nodes
Viewing Video/Audio
Viewing GPS
Recording on Monitor
View recording from
device
Download recording
Record on device and/or
server
Changing Video/Audio
settings
Erasing recordings
Disabling Video/Audio
channel

Forbidden

Aware

Passive

Active

Administrator

-

+

+

+

+

-

-

+
+
+
+

+
+
+
+

+
+
+
+

-

-

+
-

+
+

+
+

-

-

-

+

+

-

-

-

+
-

+
+

Default Access Page:
Here you can determine the default situation for
all unlisted devices and users connecting to the
server. This page will let you set how users and
devices are permitted in the system when no
other more specific rules apply.
Default Device Access Level:
This list box determines the access level for all
unlisted devices and users - if they are enabled.
The default device access level decides what a
user can do with a device if no other more
specific rule was specified.
The “Allow Unlisted Users” option, if checked,
allows general access by any user not listed in
the users list. This general access, however, is
controlled by the default device access level. The
“Allow Unlisted Devices” option, if checked,
allows general access to any device not listed in
the devices list.
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For secure server administration set the default device access level to “Forbidden”, uncheck
the “Allow Unlisted Users” and “Allow Unlisted Devices” options. Then add users and
devices and set user/device access levels in the relevant configuration pages.
Users Page:
The user is the computer/laptop/smart
phone that seeks to be a client of the server.
In order to distinguish one user from
another, a username and a password can be
created through the “MRS Service” and later
confirmed in the “Connection” feature of the
MRS Monitor/ iPhone iMRS/ Android MRS
clients.
The Users Page allows you to create new
users in the server by pressing on the “Add”
button. The “Edit User Details” page will
appear. Fill in the user name and password.
Retype the new password and click “Apply”.
All added User Names will appear in the list
on the Users Page. Click on “Edit” to change
a password of an existing user. Click on
“Delete” to delete a user from the list.
Devices Page:
Each device is distinguished from another
by a unique ID number which is given to it
by Infodraw, but can be changed by the
user. The device ID of a device can be
found and changed (if desired) in the
“Device Identification” section of the
‘Device Configuration’ program when the
unit is connected to it.
The Devices Page allows you to add new
devices to the list in the server by pressing
on the “Add” button. The “Edit Device
Details” page will appear. Fill in the device
ID and password (if desired). Retype the
new password and click “Apply”.
Click on “Edit” to change a password of an
existing device. Click on “Delete” to delete
a device from the list.
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Default Devices Access
The Default Device Access page allows you
to give an access level to registered
devices.
Click “Add” to add a default device access
directive to the list. The “Set Default User
Device Access” page will appear. Select the
device ID and default device access level
from the list boxes and click “Apply”. The
device ID’s you can select, are devices that
have been listed on the Devices page.
Click on “Edit” to change the device ID or
the access permission level for a certain
entry in the list. Click on “Delete” to delete
a specific entry from the list.



Default User Access: Assigns different permission levels to different users works along the same parameters as the Default Device access.

User Device Access Page:
The User Device Access Page allows you to
assign specific users to specific devices.
This page will list the specific device access
levels certain users are permitted on
certain devices.
Click “Add” to add a user device access
level directive. The “Set User Device
Access” page will appear. Select the user,
select the device ID and select the device
access level. The user is selected from the
users list. The device ID is selected from
the devices list.
Click on “Edit” to change the user, device
ID or access permission level for a certain
entry in the list. Click on “Delete” to delete
a specific entry from the list.
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4-4-4 Clients Menu

Traffic Summary Page:
This page displays a summary of the
general data that passes through the
server. It gives information about the
received data rate and the sent data rate
for observing the server's currently
consumed bandwidth. Click on the “Main
Menu” link to return to the main menu.

Connected Devices Page:
This page lists the connected devices: Their
IP address as seen from the server, their
numeric identifier, name and current data
rate.

Connected Users Page:
This page lists the connected Users: the
user name and the amount of data that is
sent and received from that user-client.
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File Uploads Page:
This page lists the active file uploads:
Downloading client's IP address as seen
from the server, file path and progress
information.
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4-4-5 Recordings Menu:
One of the features of the MRS system is the ability to record on the server. The ‘Recording’
section in the ‘MRS Service’ gives you the ability to control the settings of that recording and
to observe recordings which are in action.
Configure Recordings Page:
This page lets you configure the server
recording parameters.
Recording Folder: The recording folder is the
root path where server recordings are kept.
File Size Limit: The file size limit is the maximal
size of the media file. When a media file
reaches this size, the file is closed, a new media
file is created and recording continues on to the
next file.
Automatic recording in motion detection:
Check this option to start a recording of the
video channel where motion has been
detected. The recording ends after motion is
not detected for a full minute.
Delete old files to free space: Check this
option to automatically delete old server
recordings after the free space on the storage
device drops below 10%.
Sign media files: Check this option to
automatically generate a signature file for
every recorded media file. A signature file
contains an electronic signature that can be
verified with the MRS AV Player application.
Record device locations: Check this option to
automatically record all locations of devices on
the server. The server can record the device's
global position only when the device in
connected to the server and transmits its
position.

Recordings List:
This page lists the active or scheduled
recordings on the server. A recording is
considered active if the recorded
capture device is connected to the
server, or scheduled if the recorded
capture device is disconnected from the
server.

Click on “Apply” to store modified settings, or
“Main Menu” to return without making
changes.
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4-4-6 Software Updates Menu:
Updating device firmware can be accomplished remotely via the server, through the
“Software Updates" feature of the MRS Service program.
Software Updates List Page:
This page lists the update files to be sent
to devices in order to upgrade their
firmware. The software updates can
generally be enabled or disabled. If
enabled and a device connects to the
server and there is a newer version of its
firmware listed, then the server will
send the relevant update to the device.
The device will upgrade itself, restart,
and reconnect to the server with the
updated version.
Click “Enable” to enable software
updates, “Disable” to disable them,
“Main Menu” to return to the main
menu, or “Upload” to upload a new
software update file to the server.

Upload Software File Page:
Use this page to upload a new software
update file to the server. The two types of
supported files are:
Click “Browse” to select the file on your
local PC. Click “Upload” to start uploading
the file to the server.

File Type
pmrs-A_B_C_D.tgz
MRS_BlackfinDeviceSystem.ldr

Description
PMRS-102 device firmware
MRS-400 device firmware
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4-4-7 Sleep Management
If you want your device to save power and to open remotely when you tell it to or in a preset date, please enact the following instructions in order to impose a sleep regiment on your
PMRS device.


This service only applies to software and firmware version 4.5.0.0 and later.

1. Activate your device and connect it to your server -in this example we connected the
PMRS device to the IP address: "mrs1.infodraw.com"

2. After connecting the device, open

the MRS Service program by
opening your browser and entering:
SERVER_IP_ADDRESS:12654/admin
3. To configure the sleep
management, under the Sleep
management section - click on the
configure option.

4. Click on "Add Device" to install a
sleep regiment for your device.

5. Enter how often you want your device to wake up to look
for a signal or set a date for its awakening - apply the
changes.
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6. Close the device manually. It will go into sleep mode.

7. If you choose regular intervals for your device to wake up and look for a signal, a window
will open in the MRS Service program.
This window will show you the sleep regime you ordered and how many times the device
woke and went back to sleep mode (shutdowns) along with the last date of waking.
* If a device awakes after the pre-set time period is over (5 minutes for example) and the
sleep regiment is not removed it will return to sleep.
8. To change the sleeping regiment, simply click on the "Change" option.
9. To terminate the sleep mode and allow the device to go online, click on the "Remove"
option and then after the pre-set time period will expire the device will activate normally.
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4-4-8 License Menu:

License List Page:
This page lists the pay-per-use server's licenses and indicates the number of allowed
devices. A server without a license supports up to one device. For more than 1 device, a
license is required. The license depends on the hard disk volume serial number as displayed
in this page. You can obtain a license by pushing "Request License". After you receive the
license, copy the license text into the text area instead of “Enter license here”. Click on
“Add License” to add the new license.

Once the license is added, it will appear
in the list on the License List page and its
state should be "Active".
Click on “Delete” to remove an old or
non-relevant license.
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MRS Monitor Server Application:

The MRS Monitor Server
Application is used for monitoring
and controlling MRS/PMRS units. It
can also be used for setting up a
server for MRS/PMRS units and
clients to connect to. Upon opening
the application, you will see a tree
on the left-hand side with the
following features:

Item:

Description:

Speaker is off

Configure settings for your computer’s speakers.

Microphone is off

Configure settings for your computer’s microphone.

Recordings

a) View Recorded video/audio files.
b) Configure settings for local monitor recording files.

Locations

a) View the GPS map full screen showing all connected
units on it.
b) Configure trigger actions for GPS event alarms.

Visual Motion Detection

Configure trigger actions for Visual Motion Detection
event alarms.

Contacts Alarm

Configure trigger actions for the Alarm button and GPIO
event alarms.

Permissions

Set permissions and access levels for connecting units
and clients.

Online Devices

Will display all online MRS/PMRS devices.

Offline Devices

Will display all devices that have disconnected from the
server, if the device has been ticked to be remembered
by the server.

Neighbourhood

Will display information about all connected units and
clients such as: IP addresses, software versions etc.

Communication

Displays network information.
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4-5-1 Permissions:
In general each device and user can be defined with a password for authentication in the
server. Permission can be defined for users, devices and the connection between users and
devices. This can only be done using the server software.
Each user can be defined with a permission access level for a specific device. There are 5
different access levels: Administrative, Active, Passive, Aware and Forbidden.
Here are the activities which are permitted to each of those levels:
Level of Permission/
Actions Permitted
Can view online devices &
Nodes
Viewing Video/Audio
Viewing GPS
Recording on Monitor
View recording from
device
Download recording
Record on device and/or
server
Changing Video/Audio
settings
Erasing recording
Disabling Video/Audio
channel

Forbidden

Aware

Passive

Active

Administrator

-

+

+

+

+

-

-

+
+
+
+

+
+
+
+

+
+
+
+

-

-

+
-

+
+

+
+

-

-

-

+

+

-

-

-

+
-

+
+

In order to set-up permissions in the “MRS Service” program please go to pages 39-41 of
this manual.
Follow these instructions on how to setup user permission and access levels in the MRS
Monitor Server Application:

Double click on the “Permissions”
icon on the left hand side under
“My Server”, to open the “Access
Permissions” window.
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Default Access Menu:
Here you can define the users default
access level of all devices which have
not been assigned to a specific user in
the “User Device Access” menu or have
not been assigned an access level in the
“Default Device Access” menu.
You can also choose to allow or not
allow unlisted devices and users. If you
wish to assign all devices to specific
users then in the “Default Device Access
Level” list box, select “Forbidden”. Also
un-tick “Allow Unlisted Devices” and
“Allow Unlisted Users”.

Users Menu:
Each user can be defined in the server
with a password. (The password is for
authentication only).
To create a new user, select “Add”.
The “User” window will open. Enter in a
user name and password. Then press
“OK”. Your new user name will appear
in the “User Name” list.
This password will need to be entered
by that user who is trying to connect to
the server from a client.
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Devices Menu:
Each device can be defined in the server with a
password. (The password is for authentication
only).
To create a new device password, select “Add”.
The “Device” window will open. Enter in the
“Device ID” and a “Password”. Then press
“OK”. Your new device will appear in the
“Device ID” list.
This password will need to be entered in the
“Device Client password” box, in the “Device
Identification” menu, of the Device
Configurator, in order for the unit to be able to
connect to the server.

User Device Access Menu:
In this menu you can assign specific
devices to specific users. Select “Add” to
open the “User Device Access” window.
All listed User Names and Device ID’s
will appear in the drop list boxes. Select
the desired “User Name”, “Device ID”
and “Access Level”. Then press “OK”.
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Your new “User Name”, “Device ID” and
“Access Level” will now appear in the list.
This now means that this specific user is
assigned to that specific device.
To edit the applied setting, highlight the
user and select the “Change” button.
To delete the applied setting, highlight
the user and select the “Delete” button.

Default Device Access Menu:
The “default device access” screen
defines the access level of each device
which is not specified in “User Device
Access”.
To apply an access level to a device,
select “Add”. The “Default Device
Access” window will open. All listed
devices from the “Devices” menu will
appear in the “Device ID” list box. Select
the desired device and apply an access
level using the “Access Level” list box.
Then press “OK”. Your new device will
appear in the list.
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4-5-2 Software Upgrading:
The simplest ways to upgrade the MRS Software Applications and the PMRS unit firmware
are listed below.

The four main applications (MRS Monitor Server, MRS Monitor Client, MRS Device Config
and MRS AV Player) can be upgraded in each application. To do so, follow these
instructions:
1) Open the ‘Help’ menu in each application and select ‘Upgrade’.

MRS Monitor (Server) Application:

MRS Monitor (Client) Application:

MRS Device Config Application:

MRS AV Player Application:
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2) A newer version (if available) of the
application will automatically download.

3) You will then be prompted to
install the new software. Follow
the installation instructions to
complete the upgrade.
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Other Clients:

The MRS system supports an iPhone client, an Android client, Windows Mobile 5.0 and 6.0
clients and a Web Browser client.

4-6-1 iPhone Client:
The MRS system supports an iPhone client for viewing live video, audio, GPS streams, as
well as recording and controlling PTZ cameras from MRS/PMRS devices. Download the iMRS
application from the Apple Appstore. iMRS is compatible with iPhone/iPod Touch devices
using iOS 4.3 or later.
Once the iMRS application is installed on your iPhone/iPod Touch, open the application and
follow these instructions:

Upon opening the application,
the login menu will appear.
Enter in the IP address of your
server in the “Server” box and a
username and password if
required.
Turn the “Secure” option ON if
you want a secure connection
between the iPhone, the server
and the MRS/PMRS units.

The wheel on the right hand side
saves all the server IP Addresses
that you have connected to. Once
the IP addresses are saved, you
can scroll through the wheel and
select your desired server. It will
then automatically insert the IP
address into the “Server” box.
To remove a server from the list,
highlight it and press the
“Remove” button.

Once you have inserted all the details, press the “OK” button to connect to the server.
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Once you’re connected to the
server, all the connected
MRS/PMRS units will appear on this
screen.
Tap on the desired MRS/PMRS unit
to open its video channel/s for live
streaming.

If you select a PMRS-102 device, as they only have 1 video
channel, it will automatically open for live streaming.
Tap the “Microphone” icon
to speak to the unit.
Tap the “Speaker” icon to
listen to the unit’s audio
stream.

Tap the “Switch” icon to
activate a switch.

Press the “Login” button to
return to the Login screen.

Tap the “Source” button to
open the previous screen
where you can select which
connected unit and channel
you would like to view.

Tap the “Playback” icon to
watch the recoding you
created

Tap the “Map” button to
open the GPS map full
screen for live tracking of
the unit.

Tap the “REC” button to
record the video stream on
your iPhone. Tap it again to
stop recording.
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If you select the “Map” button, the GPS map will appear full
screen, as shown here.

Tap the “OSM” button
to view the GPS map
with Open Street Maps.

Tap the “Google”
button to view the GPS
map with Google Maps.

Tap the “Video” button to
return to the video stream
in full screen view.

Tap the “Standard”
button to view the map
in standard view.

Tap the “Hybrid” button
to view the map in Hybrid
view.

Tap this button to centre
the map.

The video stream can be
played over the map, as
shown here. To do so, tap
on the floating icon on the
map.
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Select the “Playback” button to open
the recordings folder where your
recordings are saved.

Select the source from which you
would like to see the recording.
Source- Is the recording that was
made on the device.
Server – The recording that was
made on the server computer.
iPhone – Open the recordings on the
iPhone.

The “Playback” screen will open. Tap
the “Select” button at the bottom
right hand side of the screen.
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Your iPhone recordings will then
appear in the list. The files are
arranged by date. Navigate through
the sub folders to locate your desired
recording.

Once you have located your desired
recording, tap on it to play it.
Tap on the “X” to delete the
recording.

The recording file will then play.
Tap “Select” to view other recordings.
Tap “Back” to go back to the live video
or GPS stream.
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To activate switches push the Switch
icon.
Choose which port you would like to
activate by sliding your finger from left
to right.
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4-6-2 Android Client:
The MRS system supports an Android Client for viewing live video/ GPS streams, as well as
controlling PTZ cameras from MRS/PMRS devices. Download the “Infodraw MRS”
application from the Google Play Store (Android Market). The Android MRS App supports
all Arm platforms with Android OS. Ensure your Android Device has an Arm compatible
chip inside. The MRS Android Client is compatible with Android 1.6 and up.
Once the MRS application is installed on your Android device, open the application and
follow these instructions:

Upon opening the application,
the login menu will appear.
Enter in the IP address of your
server in the “Server” box and a
username and password if
required.
Turn the “Secure” option ON if
you want a secure connection
between the Android device,
the server and the MRS/PMRS
units.

This list box saves all the server IP
Addresses that you have
connected to. Once the IP
addresses are saved, you can
scroll through the list box and
select your desired server. It will
then automatically insert the IP
address into the “Server” box.
Tap the “Clear” button to clear
the server list box.

Once you have inserted all the details, press the “OK” button to connect to the server.

Once you’re connected to the
server, all the connected
MRS/PMRS units will appear on this
screen.
Tap on the desired MRS/PMRS unit
to open its video channel/s for live
streaming.
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If you select a PMRS-102
device, as they only have 1
video channel, it will
automatically open for live
streaming.

Tap the “Map” button to
open the GPS map full
screen for live tracking of
the unit.

Tap the “Source” button to
open the previous screen
where you can select which
connected unit and channel
you would like to view.

Press the “Login” button to
return to the Login screen.

If you select the “Map” button, the GPS map
will appear full screen, as shown here.
Enable the “Centered” option to keep the
moving icon on the screen centred.
Tap the “Hybrid” option to view the map in
Hybrid view.
Tap the “Video” button to return to the
video stream in full screen view.

The video stream can be
played over the map, as
shown here. To do so, tap
on the floating icon on the
map.
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4-6-3 Windows Mobile Clients:
The MRS System supports a live streaming client for Smart phones/ PDA’s using Windows
Mobile 5.0 or Windows mobile 6.0 operating systems.
To install the client, follow these instructions:
1. Copy the Windows Mobile installer files onto the PDA and install the software
(Run the cab file on the PDA).
2. Run the MRS software on the PDA and set the IP of the server.
3. Connect to the server and then select the device and channel to view the video
stream.
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4-6-4 Web Browser Client:
To view the live video streams using an Internet browser open the following address:
http://”server ip”:12654/videostreams.html
This will let you view the video/GPS streams of any connected device using flash.

Select the desired video/ GPS
channel to open it for live
streaming.
If video and voice is required
(synchronized), you need to
attached the voice to one of the
video channels and location.
Place the cursor on the video
channel and right click to attach
an audio channel.
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Chapter 5 - Technical Specifications
Below are the technical specifications for the PMRS system.

5-1

PMRS Unit Specifications

Data Network
Supported Air Interfaces

HSUPA
HSDPA
3G
4G/LTE
EDGE
GPRS
WCDMA

Frequency Bands

GSM/ GPRS/ EDGE
UMTS WCDMA/ HSUPA/ HSDPA

850/ 900/ 1800/ 1900 MHz
850/ 1900/ 2100 MHz

Cellular Module

Built-in

Requires SIM card (Data only)

Cellular Antenna

External
Frequency

SMA Connector
850/ 900/ 1800/ 1900/ 2100 MHz

Bandwidth control

Automatic

Video
Video Input

1x Video Input

RCA Male Connector (through
video/power splitter cable)

Supported Cameras

Any Analogue Cameras

PAL/ NTSC

Video compression

H.264 Dual Encoding

Streaming/ recording

Video Resolution

CIF/ D1

Remote User Control

Video Bit rate

From 10kbit/s to 2Mbit/s

Remote User Control

Video Frame rate

Up to 25/30 fps

Remote User Control

Supported PTZ Cameras

Analogue
Protocol
Baud Rates

PAL/ NTSC
Pelco D
1200/ 1800/ 2400/ 4800/ 9600/ 19200/
38400/ 57600/ 115200/ 230400

PTZ Control

Built-in RS-485 Wires (T+, T-)

Through GPIO/PTZ Cable
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Audio
Audio Input

Built-in microphone or Line in

Line in through Audio Splitter Cable

Audio output

Line out

Line out through Audio Splitter Cable

Audio compression

AAC

GPS
GPS Receiver

Built-in
Frequency Band

Updates every few seconds
1575.42 MHz

GPS Antenna

External
Frequency
Waterproof

SMA Connector
1575.42 MHz
Yes (IP67)

On surface
Multiple Trigger Actions

(Input Sensor)
Streaming/ Recording/ SMS/ Noise/ GPS
Tracking

Up to 32GB (Micro SDHC)

Max bit rate based on micro SD write
speed

Input

4x Input Sensor Ports
Logic Level
User Settings Control
Multiple Trigger Actions

Built-in (Through GPIO/PTZ Cable)
TTL
Active Low/ Active high
Streaming/ Recording/ SMS/ Noise/ GPS
Tracking

Output

4x Output Ports
Logic Level
Switching
Multiple Trigger Actions

Built-in (Through GPIO/PTZ Cable)
TTL
Through MRS Monitor Software
Streaming/ Recording/ SMS/ Noise/ GPS
Tracking

Power Input

5V (Max)

AC/DC to 5V adapters

Power consumption

500mA while streaming

Battery

Built-in/ Lithium

Alarm button
Push button

Memory
Micro SD Slot

GPIO

Power

4000 mAh (4.5 hours)
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DC Male Connector (through
video/power splitter cable)

Environment
Temperature Input

-10 +60°C

Physical
Dimension

5 x 10 x 2.8 cm

Weight

130 g

Other Interfaces
USB Client

Built-in (Mini USB Input)

For Setup/ Configuration (Through USB
Cable and PC)

video/power cable

Splitter cable for video/5V power
output

RCA/DC Male Connectors

Audio in/out cable

Splitter cable for Speakers/ Mic

TRRS Female Connectors

LAN

Built-in Through external cable
interface

Ethernet Cable

Protocols
RTP/RTSP/SDP
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MRS Software Specifications:

Software:

Type:

Use:

Compatible Operating
Systems:

MRS Server (Web Admin Windows Service Program
Interface):

Server Program

Windows XP/Vista/7

MRS Monitor Server:

Server Program/
Monitoring Program

Windows XP/Vista/7

Windows XP/Vista/7

Windows Application

Windows Server
2008/2011

Windows Server
2008/2011

MRS Monitor Client:

Windows Application

Monitoring Program

MRS Device
Configurator:

Windows Application

Setup/ Configuration Windows XP/Vista/7
Program

MRS AV Player:

Windows Application

Recordings Player

Windows XP/Vista/7

MRS USB Drivers:

Windows System Drivers

For Setup of USB
Client

Windows XP/Vista/7

iMRS iPhone Client:

iOS Application

Monitoring Program

iOS 4.3 or Later

Android Client:

Android Application

Monitoring Program

Android 1.6 and Up

Windows Mobile Client:

Windows Mobile
Application

Monitoring Program

Windows Mobile
5.0/6.0
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MRS Server Technical Requirements:

Server Components

Requirements (Minimum)

Server Machine Processor (PC/ Laptop/
Dedicated Server)

Pentium 4, Dual Core

RAM

500MB

(The more units/clients connected to the
server, the better the processor will need to
be).

(The more units/clients connected to the
server, the more RAM will be required in the
server machine).
Operating System

Windows XP or higher
Server software compatible with:
Windows XP/Vista/7, Windows Server
2008/2011

IP Address

Fixed (Static)

Bandwidth

Varies depending on how many units/clients
are connected to the server and at what bit
rate the units are streaming data to the
server at.
Please consider bandwidth requirements
very carefully when setting up servers. This is
the most important factor of the server.

192

May 28, 2013

INFODRAW

PMRS-102 User Manual v5.4.1

Chapter 6 - Support
To assist you with using this product, provided below is troubleshooting help and frequently
asked questions (FAQ) for a variety of aspects in the PMRS system. There are both
troubleshooting and FAQ indexes listed below for convenience and easy navigation to
specific help.

6-1

Troubleshooting Index:

1) My server does not work. .........................................................................................................191
2) The “MRS Device Configurator” does not recognize my device .........................................191
3) The “MRS Monitor” program does not recognize my device (General) ............................192
4) The “MRS Monitor” program does not recognize my device (When connecting with the
wireless cellular modem)..........................................................................................................192
5) The “MRS Monitor” program does not recognize my device (When connecting with a
LAN connection).........................................................................................................................193
6) My MRS device is online, but I can't see the video feed from the camera my device is
connected to. .............................................................................................................................194
7) My device is online but I am not able to hear audio. ...........................................................195
8) My GPS feature does not work. ...............................................................................................195
9) The picture that appears on my monitor is always in diminished quality ........................196
10) The quality of the video/audio playback is diminished and is full of disruptions. ...........197
11) The recording folder does not appear in the device tree. ...................................................197
12) I only managed to record video without audio. ....................................................................198
13) I am connected with the cellular modem and my device is constantly restarting. ..........198
14) My device is recording and I can't get it to stop. ..................................................................199
15) I can't get my PMRS device to send an SMS messages. .......................................................199
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Troubleshooting:

1) Q: My Server does not work. How do I activate it?
A: Check the following:
1) First, make sure that your server is connected to the internet or to VPN.
2) Enter the “MRS Device Configuration” program, choose the “Connection” tab
and click the “Local Server” option if you want the device to act as a server.
3) Open the MRS Monitor program, open the “Session” menu, choose the
“Connection” option and click on the “Local Server” option.
4) Open TCP port 12654 and UDP port 12655 in the firewall to allow access to
the server.
5) If you have an anti virus program installed on your PC, make sure it is not
blocking the inbound/outbound traffic of these ports.
6) Make sure you enter the correct IP address of your server in the Device
Configurator.

2) Q: The “MRS Device Configurator” does not recognize my device.
A: Check the following:
1) Make sure that your device is connected with a USB cable to your PC.
2) If you have a PMRS device, make sure that DIP switches 1 and 2 are in an
“up” position.
3) Try switching USB ports in your PC, if that fails, try to connect your device to a
different PC and/or a different USB cable.
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3) Q: The “MRS Monitor” program does not recognize my device (General).
A: Check the following:
1) Make sure that the device is on.
2) Wait for a few minutes before determining that there is no connection. It can
take around 3 minutes for the device to be recognized by the software.
3) Make sure that the red and blue LEDs (if the modem is operational) are
blinking. If the blue LED does not work, make sure that the device is
connected properly to the GSM antenna.
4) Enter the “MRS Device Configurator” program. Open the “Connection” tab.
Enable the “Remote Server” option, configure your IP address so that it
would match your server address. Check that your server is operational.
5) Open the “MRS Device Configurator” program and choose the “Device
Identification” tab. Make sure that the device ID number is above 0 and
under 2,000,000,000.
6) Open the “MRS Monitor” program, open the “Session” menu and choose the
“connection” option. If you choose to use your device as a client (not server)
enable the “Remote Server” option. Make sure that the server address, user
name and password (if required) are correct.
7) Enter the “Permissions” feature of the “MRS monitor” program in your server
and verify that your device is permitted to access the server.
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4) Q: The “MRS Monitor” program does not recognize my device (When connecting
with the wireless cellular modem).
A: Check the following:
1) Hardware:
a) Make sure that the SIM card is activated (by trying to go on the web with
your cell phone) and that it is properly placed in the device - on its rail, face
up. If you are not able to activate your SIM card, contact your Cellular
provider.
b) Make sure that the GSM antenna is properly screwed-in to the device. Make
sure the antenna is not screwed-in the GPS slot by mistake (with the
exception of some PMRS devices which only have one antenna slot for GPS).
c) DIP switches 1 & 2 should be in “down” position when using the wireless
cellular modem.
2) Software:
a) In order to configure your device, you need to connect a USB cable, and
activate the “MRS Device Configuration” program. If you have a PMRS device
you need to raise Dip switches 1 & 2 which are placed on the side of the
device.
b) Enter the Modem tab. Select the “Manual” option and fill in the information
of your modem. The information should be given to you by your cellular
provider.
c) If your cellular provider tells you that your SIM card is locked, open the “MRS
Device Configuration” program. Open the SIM tab on the left side of your
window. Fill in the PIN and PUK details which will be given to you by your
provider.
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5) Q: The “MRS Monitor” program does not recognize my device (When connecting
with a LAN connection).
A: Check the following:
1) Hardware:
a) Make sure that the network cable is connected to the device and to your PC
(if you are connected through your PC).
2) Software:
a) Open the Configurator program by connecting the USB cable and raising Dip
switch number 1&2. Enter the “Local Network” section, choose the DHCP
option (dynamic IP) or the manual option (static IP), and fill in the details
necessary. Save the changes and restart the device.

6) Q: My MRS device is online, but I can't see the video feed from the camera my
device is connected to.
A: Check the following:
1) Open your device folder by pressing on the + sign, and drag the camera icon to
one of the video channels.
2) Make sure that your device is connected to the camera and that the camera is
activated (being powered).
3) Try to double click on the icon of the Camera.
4) Right click the icon of the camera in the folder of your device and make sure that
there is a “tick” next to the Enable option, then wait for about 2 minutes before
the video is enabled again.
5) Press the F3 button on the video channel and make sure that the settings of the
video channel are compatible with the settings of the camera (especially the
Image size – PAL or NTSC).
6) Go to your server, enter the “Permissions” menu, and check that your device is in
a “passive” access level or higher, or that unlisted device and users are allowed.
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7) Q: My device is online but I am not able to hear audio.
A: Check the following:
1) Make sure that your headphones are operational and connected to your PC. You
can confirm your headphones are working by performing the audio test:
– Under the “My Monitor” tree double-click the icon that says 'Speaker is off'.
– A window will appear with the headline “Select audio output device”. Click on
"Test". If you are able to hear a beep, your headphones are operational.
* If you do not hear the beep you may have to raise the volume of your
headphones or use other headphones.
2) Open the “Online devices” tree in the monitor program and open the tree of
your own device. Double click on the speaker icon. Open the monitor tree on the
left side of your screen and make sure that it shows “Speaker is on” and that next
to it, the name of your device is written.
3) Make sure that DIP switch number 3 is in “down” position.
4) Open your device tree and right click the “audio-in” icon, click on the properties
option in the menu. Observe the Sample rate, if the sample rate is 32000Hz than
the bitrate has to be lower than 18, if it is 18 and above – audio will not work.
This problem can also be resolved by raising the sample rate to 44KHz or 48KHz.

8) Q: My GPS feature does not work.
A: Check the following:
1) Wait. It can take up to 30 minutes (on average 5 mins.) for the GPS feature to
appear.
2) The GPS antenna needs to be in the clear sky.
3) Screw-in your GPS antenna, make sure that it is in the correct socket and that it is
placed with some distance from the GSM antenna.
4) Open the MRS Configurator program, enter the GPS tab on the left side of the
window and check the “Activate GPS” and the “Reset GPS” options are enabled.
5) To confirm the GPS is working. Open your device tree in the monitor program
and observe as the co-ordinates of the GPS are changing.
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9) Q: The picture that appears on my monitor is always in diminished quality.
A: Check the following:
1) Camera problems: Make sure that your camera is in focus and is able to produce
a high quality picture. You can test the quality by recording on your camera and
then watching the recording you have made on your PC.
2) Video Definitions: Click the video channel that you are observing and press the
F3 button on your keyboard. Enter the video properties:
– Make sure that the image size fits your camera settings.
– Make sure that the frame rate and bit rate are high enough to allow a good
quality picture (recommended: Frame Rate: 10, Bitrate: 200)
3) Low Signal Strength (Modem):
a) In the “MRS Monitor” program, open the device tree by pressing the + sign
next to the device icon on the left side of your window. The GSM “signal”
icon should appear within about 10 minutes after activation. The signal
should be between 50%-100% in order to receive good quality video.
b) Connect your device to the MRS Device Configurator. Make sure that the
“Tolerance” level is set to “High” in the “Connection” menu of the Device
Configurator.
c) Put the SIM card in a mobile phone and check how strong the signal is on the
phone. If it is low on the mobile phone, then it is the cellular provider which
is not giving you the reception level that you require.
d) Make sure that your GSM antenna is in an upright position in the clear sky. If
your PMRS device has an internal GSM antenna, contact your local Infodraw
dealer and ask for a device with an external GSM antenna connector.
e) In a normal environment, the GSM antenna that was provided to you with
the PMRS device should allow you to receive good quality picture. If you are
in a location that suffers from an exceptional amount of disturbances, it is
possible to enhance the signal of your GSM by acquiring a more powerful
antenna from electronics shops in your area.
f) After activation, it takes about 30 seconds for the device to adjust itself, so a
few disturbances are not out of the ordinary when initially activating the
device.
4) Low Uploading/Downloading ability of the server: Make sure your server has
enough Upload/Download bandwidth to support the amount of units you are
streaming through the server.
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10) Q: The quality of the video/audio playback is diminished and is full of disruptions.
A: Check the following:
1) The real time feed may have been in bad quality, which can cause the recording
to be in bad quality.
2) If you are watching the playback from your device:
Free Some of the bandwidth on your cellular modem:
– Close real-time video and audio, and activate the playback.
– You can download the file to your PC by right-clicking on the playback file and
choosing the download option. After the download is complete you will be able
to watch the video from your monitor recordings tree which will probably be in
better quality.
3) If you are watching the playback from your Server:
– Close other programs that may require large amounts of memory usage.
– You can download the file to your computer by right-clicking on the playback
file and choosing the download option. After the download is complete you will
be able to watch the video from your monitor tree which may be in better
quality.
4) If you are watching the playback from your monitor:
– Close other programs that may require large amounts of memory usage.
– Resolve issues that may disturb the fluent function of the operating system on
your PC.

11) Q: The recording folder does not appear in the device tree.
A: Check the following:
1) The recordings folder will only appear in the PMRS device tree on the MRS
Monitor if a Micro SD card is inserted into the device.
2) The recording folder may also not appear because the Micro SD card is not
recognized. Switch off the unit and try re-inserting the micro SD card again.
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12) Q: I only managed to record video without audio.
A: Check the following:
1) Make sure that your headphones/ microphone connected to the PMRS unit are
operational.
2) Double-click the “speaker” icon in the PMRS device tree. Then open the “My
Monitor” tree and look at the speaker status. It should say “speaker is on” with
the name of your device listed beneath it.
3) Attach audio to video. Right-click on the camera that you want to record from
and choose the option “Attach Audio Channel”. Then attach the audio channel
you want to record alongside the video channel. After you record the video
channel, the recorded file should have synchronised audio in it.

13) Q: I am connected with the cellular modem and my device is constantly restarting.
A: Check the following:
1) Constant restarting usually indicates a weak connection to the server:
a) Open the MRS device configuration and make sure the tolerance level of the
device is “High” in the “Connection menu”.
b) Check to see if the other devices which are connected to the server are

frequently restarting as well. If so, make sure that the internet connection to
your server is without disruptions.
2) Constant restarting can also be caused by weak cellular (GSM) reception. If you
are using the unit in areas with low reception, move the unit to higher reception
areas and see if that fixes the problem.
3) If you are streaming the unit’s video stream at a Bit Rate and Frame Rate that is
excessively higher than the supported cellular network bandwidth, this may also
cause the unit to crash and restart.
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14) Q: My device is recording and I can't get it to stop.
A: Check the following:
1) Right-click on the video channel which is recording and look for the recoding
option that has a “Tick” next to it. Click on it to disable the recording.
2) If the video stream is recording as a result of a Visual Motion Detection (VMD)
trigger, click on the video channel that is recording.
– Press F3 to reach the video properties window.
– Disable motion detection.
– Try to stop the recording again (as explained in the first answer).

15) Q: I can't get my PMRS device to send SMS messages.
A: Check the following:
1) Make sure that the SMS feature, under your device tree in the MRS Monitor
Program is enabled and that your mobile number is entered correctly.
2) If your phone number is correct and you are still not receiving SMS messages:
– Open the Device Configurator program.
– Click on the SMS tab on the left side of your screen.
– Fill in the connection SMS number.
– Choose a different option in the “Send Service Type”. Some cellular providers
need a different service type in order to work. (Recommended: Circuit Switched).
– Save the changes to the device and restart.
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Frequently Asked Questions (FAQ):

1) Q: How do I know if my PMRS device hardware is working?
A: Observe the LED lights. In any situation the center-red coloured LED has to be
illuminated or blinking. The green LED indicates an external power source. The third LED
light (the blue LED), has to be operational and blinking if a cellular modem is inserted in
the device and is working.
2) Q: How do I download the MRS software to my PC?
A: From a disk given to you by your local distributor.
3) Q: How do I operate the “MRS Device Configuration” Program?
A: When connecting the PMRS device to the “Device Configurator”: Raise DIP switches
1&2 (which are the small switches on the side of the device) to “up” position. Connect a
USB cable between the unit and a PC, open the “MRS Device Configurator” program and
then activate the PMRS device. Make sure your SIM card is not inserted into the device
when connecting to the Device Configurator
4) Q: How do I know if my device is online?
A: Open the “Media Relay System Monitor” program or the “Mobile Mind” program and
check if an icon (with your device name on it) appears on the left side of your screen
under the “Online Devices” tree. If so, you are connected. It may take up to 3 minutes
after activating the PMRS device for it to appear on the MRS Monitor.
5) Q: How do I save the changes that I have made in the configuration program?
A: Every time that a change is made in the MRS Device Configuration program, those
changes need to be saved/ burned into the device and the device needs to be restarted.
In order to save the changes that you have made in the configuration program on your
device, you have to enter the “File” menu and choose the “write on device” option. You
then have to wait until the status bar on the bottom left side of your window shows
“Parameters Saved”. Only after restarting your device will these changes take effect.
6) Q: How do I know if my server is operational?
A1: If you are working from the server computer then you should open the “MRS
Monitor” program. In that program, there is a status bar on the bottom-left side of your
window. That status bar should show the following message: “Server is Listening”.
A2: After confirming that the server is listening, enter the “Neighbourhood” tree. There
you should be able to observe all the devices which are connected to your server. If you
can connect to the “MRS Server Windows Service Program” or the “MRS Monitor Server
Application” from a MRS Client, then your server is operational.
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7) Q: How do I find the ID number of my device?
A1: Attach your device to a USB cable and open the MRS Device Configurator program.
Open the device Identification tab. There you will find the device ID number.
A2: Open the MRS monitor program. Double-click on a connected device name. This will
display the device ID number.
8) Q: How can I see the video from the camera my device is connected to?
A1: PMRS Device: Connect the camera either directly to the 2.5mm TRRS Female
connector located on the top of the device (which has “A/V in” written beside it), or to
the Video/Power adapter cable (RCA/DC connectors), which is included with the unit.
A2: Open the MRS Monitor program. Open the “Online Devices” tree by clicking the “+”
sign next to it. Open your device tree by Double-clicking on the icon that has your
“device name” written on it. Double click on the icon of the camera that you want to
view. Or drag the icon in to the video channel you wish for it to stream in.
9) Q: How do I record video?
A1: Right-click on the video channel you want to record. A menu will appear. At the
bottom of the menu you will have 3 options: Record on monitor/server/device. Choose
one or more of them and the program will start recording on the destination you
chose.
A2: In the headline of the video stream, you will see a red letter which symbolizes the
destination you have chosen to record to: M/S/D.
A3: To end recording, simply right click again on the video channel and click on the
recording that you chose before, that has a “Tick” next to it.
10) Q: How do I change the amount of video channels on the screen?
A: Open the “view” menu in the MRS monitor. Choose how many channels you want to
open at the same time, from the selection at the bottom of the menu.
11) Q: How do I magnify one video channel to full-screen?
A: You can double-click on one of the video channels to magnify it to full screen.
12) Q: How do I activate the internal microphone in the PMRS device?
A: If you have a PMRS device, flip DIP switch number 3 into down position to activate
the internal microphone. Open the device tree in the MRS Monitor program and double
click on the “Audio in” icon to open the audio stream between the unit and the MRS
Monitor application.
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13) Q: How do I hear an external microphone from my PC on to the device?
A1: Connect headphones to the PMRS device. Connect headphones either directly into
the 2.5mm TRRS Female Connector which has an imprint of “headphones” next to it, or
connect a speaker unit to the Audio In/Out Adapter Cable, included with the unit.
A2: Open the device tree in the MRS Monitor Application and double-click on the
“Audio-out” icon to activate the audio stream.
14) Q: How do I update the software on my device?
A: Connect the unit to external power while upgrading. Connect the PMRS Device to the
“Device Configurator Program”. Open the “upgrade” tab on the left side of your screen.
Click on the “download” button to download the latest firmware version. After the
download has finished, it will automatically prompt you to “Begin Programming”. Click
“OK”. Wait until the firmware programming is finished. DO NOT interrupt the upgrade
process. Once the programming is complete, restart the unit. When it reloads onto the
Device Configurator, it will be upgraded to the newest version.
15) Q: How do I turn my PMRS device into a cellular router?
A: Connect the PMRS unit to the Device Configurator. Open the “Local Network” section
on the left side of your screen. Choose the “manual” option. Fill in the details of the Host
and the Subnet Mask and leave the rest empty. For example:
Host: 10.0.0.1
Subnet: 255.0.0.0
or:
Host: 192.168.0.1
Subnet: 255.255.0.0
Tick the “Enable DHCP Server” option. Save to the Device and exit. The unit will now act
as a 3G router. Connect the Ethernet cable to your PC/Laptop.
16) Q: How do I prevent certain users and devices from accessing my server?
A1: Open the “MRS Server Windows Service Program” or the “MRS Monitor Server
Application”.
A2: Enter the “Permissions” feature of the server. In order to be selective in your
permissions, you should disable the “Allow unlisted Devices” option and the “Allow
Unlisted Users” option in the “Default Access Menu”.
A3: Add users in the “Users” Menu. Add devices in the “Devices” menu.
A4: Enter the “User Device Access” menu in the permissions feature. Press add, and
enter the details of the user, the device and clearance level you wish to give
them and press “ok”.

206

May 28, 2013

INFODRAW

PMRS-102 User Manual v5.4.1

17) Q: What do the different access levels mean?
A1: Forbidden: The user/device are not allowed to access the server at all.
A2: Aware: you are able to see the device is online but you can't see video, hear audio or
change any of the settings.
A3: Passive: The user is allowed to view video and hear audio but can only record on
monitor. The user cannot activate switches, the audio-out function or enable/disable
channels.
A4: Active: The user is allowed to view, listen, modify video and audio parameters,
record on the device and speak to the device. The user is not allowed to enable and/or
disable channels and a few other advanced options.
A5: Administrative: The user is allowed to do everything in the system.
18) Q: I have a camera with PTZ. How do I activate it?
A1: You must make sure the camera uses a Pelco-D camera engine protocol.
A2: Open the “MRS Device Configuration” program. Open the “PTZ” tab. Press “add” to
match the video channel with the Camera ID. For example:
Video Channel: 1 and Camera ID: 1.
Set the Baud Rate that you desire in the “Baud Rate” list box. Save changes and restart
the device. The same Camera ID and Baud Rate settings must be set on the PTZ camera
itself. Connect the PTZ camera to the unit through the video input and RS-485 wires.
A3: Open the MRS monitor program. Click on the relevant video channel. A small
window should open on the bottom-left side of the screen with a yellow ball. Point the
camera to where you want it to move to.
19) Q: How do I use the SMS feature in the MRS monitor?
A: Double-click on the SMS icon that is in the device tree. In the SMS window, tick the
“enable” box. Enable the events that you want to trigger an SMS. Write down the
message you want to send. Fill in your name and phone number. Click on “add”. Then
click “apply”.
20) Q: How do I delete files of recordings?
A: The default configuration of the MRS system is designed to automatically erase old
files when your storage disk is full. New files are recorded on the device over the old
files. Therefore there is no need to erase files to make space for new recordings.
However if you still want to erase a file, click on the recording you want to delete and
press the “Delete” button. Alternatively, right-click on the recording file and choose the
delete option.
21) Q: I would like to connect trough VPN, how do I make this happen?
A: Enter the “MRS device Configurator” program. Open the “Modem” tab. Choose the
“manual” option. Fill in the details of your network. Save the changes and restart your
device.
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22) Q: I have an iPhone. How do I download the iMRS?
A: Enter the Apple App-Store and download the iMRS application. The iMRS application
is Free to download.
23) Q: I have an android phone. How do I download/update the MRS Program?
A: Go to the Google Play Store (Android Market) and search for Infodraw MRS. Install
the MRS App. Android MRS is Free to download.
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Contact Us
Infodraw Israel R&D LTD (Global Headquarters)
14 Aba-Hillel St. Ramat-Gan, Israel
Tel: +972-3-6127434
www.infodraw.com
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